# Table of Contents

**ADF-GUI Reference Manual** ........................................................................................................ 1
**Table of Contents** .......................................................................................................................... 2
**Introduction** .................................................................................................................................. 9
  **The ADF-GUI modules** .................................................................................................................. 9
  **The SCM (logo) menu** .................................................................................................................. 10
  **Environment Variables** ............................................................................................................... 11
**Mouse Interaction** .......................................................................................................................... 12
  **Rotate, Translate and Zoom** ....................................................................................................... 12
  **Selecting** .................................................................................................................................... 12
**Shared Menus** ............................................................................................................................... 13
  **Edit Menu** .................................................................................................................................. 13
  **View Menu** .................................................................................................................................. 13

- **Reset View** ............................................................................................................................... 13
- **View Direction** ............................................................................................................................ 13
- **Parallel Perspective** ................................................................................................................... 13
- **Fly to selection** .......................................................................................................................... 14
- **Align screen** ............................................................................................................................... 14
- **Mouse as** ................................................................................................................................... 14
- **Anti-alias** .................................................................................................................................... 14
- **Axes** .......................................................................................................................................... 14
- **Molecule Ball & Sticks** ............................................................................................................... 14
  - **Molecule Resolution** ............................................................................................................... 14
  - **Balls And Sticks** ....................................................................................................................... 15
  - **Sticks** ..................................................................................................................................... 15
  - **Wireframe** ............................................................................................................................... 15
  - **Show Bond Type** .................................................................................................................... 15
  - **Color Bonds By Atoms** .......................................................................................................... 15
  - **Bigger, Smaller** ....................................................................................................................... 15
- **Background** ................................................................................................................................ 15
- **Atom Info (name, charges, etc)** ................................................................................................. 15
- **Color Atoms By** .......................................................................................................................... 16
- **Atom Radius From** ..................................................................................................................... 16
- **Geometry Info** ............................................................................................................................. 16
- **Info Style** ................................................................................................................................... 16
- **Hide Hydrogen Atoms** ............................................................................................................... 16
- **Show Bonds To Hidden Atoms** ................................................................................................ 16
- **Show Unit Cell** .......................................................................................................................... 16
- **Periodic** ...................................................................................................................................... 16
**Popup Menus** ................................................................................................................................. 17
**ADF-GUI modules** ........................................................................................................................ 18
  **ADFjobs** ..................................................................................................................................... 18

- **Introduction** .............................................................................................................................. 18
- **Starting ADFjobs** ....................................................................................................................... 18
- **Use as Launcher (ESC key)** ....................................................................................................... 18
- **Queues** ..................................................................................................................................... 19
  - **Interactive Queue** ................................................................................................................... 19
  - **Sequential Queue** ................................................................................................................... 19
  - **Setting up your own Queues** .................................................................................................. 20
  - **Dynamic queues** .................................................................................................................... 22
- **File and Job listing** .................................................................................................................... 22
  - **Job elements** ............................................................................................................................ 22
  - **Job status (including WARNING and ERROR info)** .............................................................. 23
  - **Selecting** ................................................................................................................................ 23
  - **Changing directories, open a job, change a job name** .......................................................... 24
Presets and Defaults ................................................................. 43
Use a Preset ............................................................................ 43
Revert to preset values ............................................................ 44
Color Code ............................................................................. 44
Make your own presets ............................................................ 44
Defaults .................................................................................. 45

Buttons and Tools .................................................................. 40
Getting and changing geometry details .................................. 41
Keyboard shortcuts .................................................................. 41
Pre-optimizer: SimpleMM ........................................................ 42
Other ways to pre-optimize ...................................................... 42
DFTB ...................................................................................... 42
MOPAC ................................................................................... 43
OpenBabel ............................................................................... 43

Save As .................................................................................. 34
Revert .................................................................................... 34
Save Picture ........................................................................... 34
Default Picture Format .......................................................... 34
Picture Resolution ................................................................. 34
Run ....................................................................................... 35
Quit ....................................................................................... 35

Edit menu ............................................................................... 35
Undo ..................................................................................... 35
Redo ..................................................................................... 35
Clear ..................................................................................... 35
Group .................................................................................... 35
Ungroup ................................................................................ 35
Set origin ................................................................................ 36
Symmetry ............................................................................... 36
Mirror .................................................................................... 37
Align ...................................................................................... 37

Select menu ............................................................................ 37
Select All ............................................................................... 37
Invert Selection ...................................................................... 37
Select Molecule ....................................................................... 37
Select Connected ................................................................... 37
Select Within Radius ............................................................. 38
Select Atoms Of Same Type ................................................... 38
Select All Bonds ..................................................................... 38

Atoms menu ............................................................................ 38
Delete Atom(s) ........................................................................ 38
Fuse Atoms ............................................................................. 38
Change Atomtype ................................................................. 38
Ghosts .................................................................................... 38
Details (Color, Radius, Mass, ...) .......................................... 39
Add Hydrogen ......................................................................... 39
Remove Hydrogen ................................................................... 39
Replace By Structure ............................................................ 39

Bonds menu ............................................................................ 39
Bond Lengths constrained ..................................................... 40
Add Bond ............................................................................... 40
Guess Bonds .......................................................................... 40
Remove Bonds ....................................................................... 40
Bond Order ............................................................................ 40

View menu .............................................................................. 40
Standard View commands .................................................... 40

Help menu .............................................................................. 40
TAPE21 and logfile........................................................................................................... 71
ADFmovie files .................................................................................................................. 71
Geometry Information ...................................................................................................... 71
Menu Commands .............................................................................................................. 72
  File: Open....................................................................................................................... 72
  File: Save Geometry...................................................................................................... 72
  File: Update Geometry in Input .................................................................................... 72
  File: Save Picture......................................................................................................... 72
  File: Save Movie Frames.............................................................................................. 72
  File: Save .mp4 Movie.................................................................................................. 72
  File: Save Movie Coordinates.................................................................................... 72
  File: Default Picture Format....................................................................................... 72
  File: Picture Resolution .............................................................................................. 73
  File: Quit ...................................................................................................................... 73
  View: Standard Commands......................................................................................... 73
  View: Loop................................................................................................................... 73
  View: Converged Geometry Only................................................................................ 73
  View: Displacement Vectors....................................................................................... 73
  View: Scale Displacements........................................................................................ 73
  Graph: Energy............................................................................................................. 73
  Graph: Optimizer Energy............................................................................................ 73
  Graph: Distance, Angle, Dihedral.............................................................................. 74
  Add Graph ................................................................................................................... 74
  Delete Graph............................................................................................................... 74
  Delete Curve................................................................................................................ 74
  Curve On X Axes........................................................................................................ 74
  Curve On Left Axes..................................................................................................... 74
  Curve On Right Axes................................................................................................... 74
  Quid Energies............................................................................................................. 74
  Save As PostScript...................................................................................................... 75
  Save As XY ................................................................................................................ 75
ADFlevels ......................................................................................................................... 75
  Introduction ............................................................................................................... 75
  Starting ADFlevels..................................................................................................... 75
  ADFlevels window .................................................................................................... 75
  Stacks: Molecule, Fragment types, Fragments ......................................................... 75
Mouse interaction ............................................................................................................ 76
  Zooming and Translating........................................................................................... 76
  Selecting...................................................................................................................... 76
  Moving a stack.......................................................................................................... 76
Menu commands............................................................................................................. 76
  File: Open................................................................................................................... 76
  File: Add...................................................................................................................... 76
  File: Save Postscript................................................................................................. 76
  File: Quit .................................................................................................................... 77
  Axes: Reset Zoom...................................................................................................... 77
  Axes: Unit................................................................................................................... 77
  View: Interactions..................................................................................................... 77
  View: Occupations................................................................................................... 77
  View: Labels.............................................................................................................. 77
  View: Fragments....................................................................................................... 77
  View: Fragment Types.............................................................................................. 77
  View: Hide Stacks...................................................................................................... 77
Help ............................................................................................................................... 77
Pop-up menus ................................................................................................................. 78
  Background (white space) pop-up............................................................................. 78
  Stack pop-up............................................................................................................. 78
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level pop-up</td>
<td>78</td>
</tr>
<tr>
<td>ADFtail</td>
<td>78</td>
</tr>
<tr>
<td>Introduction</td>
<td>78</td>
</tr>
<tr>
<td>Starting ADFtail</td>
<td>78</td>
</tr>
<tr>
<td>ADFtail window</td>
<td>79</td>
</tr>
<tr>
<td>ADFoutput</td>
<td>79</td>
</tr>
<tr>
<td>Introduction</td>
<td>79</td>
</tr>
<tr>
<td>Starting ADFoutput</td>
<td>79</td>
</tr>
<tr>
<td>ADFoutput window</td>
<td>79</td>
</tr>
<tr>
<td>Click on Marked Items</td>
<td>80</td>
</tr>
<tr>
<td>Include Menu</td>
<td>80</td>
</tr>
<tr>
<td>Other Menus</td>
<td>80</td>
</tr>
<tr>
<td>GUIprefs</td>
<td>80</td>
</tr>
<tr>
<td>Preferences</td>
<td>80</td>
</tr>
<tr>
<td>Save and Preview</td>
<td>80</td>
</tr>
<tr>
<td>Display</td>
<td>81</td>
</tr>
<tr>
<td>Colors</td>
<td>81</td>
</tr>
<tr>
<td>Atom Colors</td>
<td>81</td>
</tr>
<tr>
<td>Fields</td>
<td>81</td>
</tr>
<tr>
<td>ADFjobs</td>
<td>81</td>
</tr>
<tr>
<td>Environment</td>
<td>82</td>
</tr>
</tbody>
</table>
Introduction

This document will provide a basic reference manual of the ADF-GUI. The ADF-GUI is the Graphical User Interface for the ADF package.

If you are new to the ADF-GUI we advise you to read (and try) the ADF-GUI tutorials before reading this reference manual.

Primary author of the ADF-GUI: O. Visser

Artwork: M. Luppi, www.wrinklypea.com

Other contributors: E. van Lenthe, A.L. Yakovlev, W.J. van Zeist

The ADF-GUI modules

The ADF-GUI consists of several modules:

ADFjobs

This utility ($ADFBIN/adfjobs) manages your ADF jobs: run a job on your local machine or on remote machines. It also serves as a interface to all files belonging to your job, and it serves as a convenient launcher of the other ADF-GUI modules.

ADFinput

This program ($ADFBIN/adfinput), which enables ADF users to easily create ADF jobs. You can use ADFinput to define your molecule (geometry), pre-optimize it, and to set details of your ADF job using an easy-to-use graphical user interface. ADFinput will generate the complete job script for you. This script takes care of running ADF and property programs as required.

ADFview

A simple program ($ADFBIN/adfview) that displays volume data, such as electron densities, orbitals, electrostatic potentials and more. It also shows scalar atomic data (like charges).

ADFmovie

This program ($ADFBIN/adfmovie) follows geometry steps as performed by ADF during geometry optimizations, IRC calculations, etc. Actually, it will display just any series of changing geometries, and is also used to display normal modes calculated with a frequency calculation. It can also show graphs of several properties as a function of the geometry step.

ADFlevels

This program ($ADFBIN/adflevels) generates a diagram showing the energy levels of a finished calculation. You can interact with it: show an interaction diagram (how the molecular orbitals are constructed from fragment orbitals), show labels, occupations, orbitals, etc.

ADFspectra

This program ($ADFBIN/adfspectra) the spectra calculated by ADF. It can show IR, PVDOS, Raman, Excitation, MCD, VCD and CD spectra, as well as a DOS plot. For some spectra it can also provide additional information, like a visualization of the normal modes or orbitals.

ADFdos
This program ($ADFBIN/adfdos) shows the DOS graphs for ADF. Both the full DOS and partial DOS is available: you can select which atoms (or even which functions on some atom) should participate in the DOS.

ADFtail

A minor ADF-GUI utility ($ADFBIN/adftail) that will just show the contents of a text file, updating when the text file grows (like the UNIX tail -f command). It is used to monitor the 'logfile'. The progress of an ADF calculation is always written to this file.

ADFoutput

A output browser ($ADFBIN/adfoutput) for the output generated by ADF. It displays the full output file, and provides short-cuts to the most common things of interest (including properties).

GUIprefs

All preferences that are being used by the ADF-GUI and the BAND-GUI.

The SCM (logo) menu

All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. In this menu all ADF-GUI and BAND-GUI modules are listed, as well as COSMO-RS and some general commands. Some modules are specific for the ADF-GUI or the BAND-GUI, these start with ADF or BAND respectively. The other modules may be used with both the ADF-GUI and the BAND-GUI.

You can easily switch between the different modules of the ADF-GUI using this menu:

- ADF Input: activate ADFinput
- ADF Levels: activate ADFlevels
- COSMO-RS: activate COSMO-RS
- BAND Input: activate BANDinput
- BAND Structure: activate BANDstructure
- View: activate ADFview
- Movie: activate ADFmovie
- Logfile: activate ADFTail
- Output: activate ADFoutput
- Spectra: activate ADFspectra
- Dos: activate ADFdos
- Close: close all ADF-GUI modules for the current or (in ADFjobs) selected, calculation
- Close All: close all ADF-GUI modules at once
- Preferences: activate GUIprefs, set preferences for all modules
- Jobs: activate ADFjobs

When you use the SCM menu while some file is connected to the current ADF-GUI module, the selected ADF-GUI module will be activated showing data belonging to the same calculation. The title bar of any ADF-GUI module shows which file is connected, if any. Thus, you can easily switch between viewing the logfile, output, input, orbitals, etc, all belonging together.

When you use the SCM menu when no file is connected (the title bar just shows the name of the module), the selected ADF-GUI module will be started without file.

Selecting a menu command from the SCM menu while the control key is pressed down will start the selected module with no file. An alternative in ADFjobs is to clear the selection first (using the ESC key).

On most platforms you can tear off the SCM menu by selecting the dashed line at the top of the menu.
## Environment Variables

In the following table the environment variables that are specific for the ADF-GUI are listed:

<table>
<thead>
<tr>
<th>Name</th>
<th>Meaning</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCM_ERROR_MAIL</td>
<td>e-mail address for error reports</td>
<td>no error e-mail sent</td>
</tr>
<tr>
<td>SCM_GUIRC</td>
<td>location of the preferences file</td>
<td>$HOME/.scm_guirc</td>
</tr>
<tr>
<td>SCM_TPLDIR</td>
<td>location of the templates directory</td>
<td>none (no extra templates loaded)</td>
</tr>
<tr>
<td>SCM_STRUCTURES</td>
<td>location of the structures directory</td>
<td>none (no extra structures loaded)</td>
</tr>
<tr>
<td>SCM_RESULTDIR</td>
<td>location of the results directory</td>
<td>none (current directory used)</td>
</tr>
<tr>
<td>DISPLAY</td>
<td>X-window display to use</td>
<td>required (for all X11 programs) except on Windows</td>
</tr>
<tr>
<td>SCM_MOPAC</td>
<td>command to start MOPAC</td>
<td>none (default script $ADFBIN/mopac.scm will be used)</td>
</tr>
<tr>
<td>SCM_QUEUES</td>
<td>path to the dynamic queues directory</td>
<td>none (ADFjobs will search the remote $HOME/scmgui)</td>
</tr>
</tbody>
</table>
Mouse Interaction

Rotate, Translate and Zoom

In the modules that provide a 3D view of your molecule (currently ADFinput, ADFview, ADFmovie, ADFspectra and ADFdos) you can rotate, translate and zoom using the mouse.

Drag with the mouse: press a mouse button, and move it while holding it down. A one-button mouse button is the same as a Left mouse button. Which mouse button, and which modifier key you press at the same time, determines what will happen:

- **Rotate**
  - Left
  - Rotate in-plane Ctrl-Left
- **Translate**
  - Middle, or Alt-Left
- **Zoom**
  - Right, or Command-Left (drag up or down), or use the scroll wheel on your mouse

The rotate, translate and zoom operations change how you look at the molecule. They do not change the coordinates.

In ADFinput operating with the mouse on the selection will move the selection only. In that case the geometry of your molecule (and thus the coordinates) will change. Zooming the selection will move it perpendicular to the screen, unless you are using the mouse-wheel. You operate on the selection by starting the drag operation with the mouse above a selected object.

In the View menu you can select either 'Mouse as trackball' or 'Mouse as joystick'. If 'Mouse as trackball' is selected, you need to drag with the mouse (move the mouse with a button pressed down). If 'Mouse as joystick' is selected you just need to press and keep the button pressed down. The direction of movement etc will depend on the position of the mouse with respect to the center of the 3D view area.

Selecting

In the modules that provide a 3D view of your molecule (currently ADFinput, ADFview, ADFmovie, ADFspectra and ADFdos) you can make selections using the mouse.

- Click on an object: make a new selection with it
- Click in space: clear selection
- Shift-Click on object: add or remove it from the selection
- Shift-Drag in space: add all objects within the rectangle to the selection

In some modules there are additional ways to select objects using menu commands. Furthermore, one can select atoms from the list in the coordinates window.
Shared Menus

Edit Menu

The Edit menu allows you to cut, copy and paste text.

If your mouse is over the area where your molecule is visible (the left side of ADFinput), you can also use Cut, Copy and Paste on your molecule or part of it.

This also works when copying in one window, and pasting it in another. This is an easy way to pass molecules from BANDinput to ADFinput or to REAXFFinput, or between different ADFinput windows. If you copy some molecule data from BANDinput, also the lattice vectors will be copied. Next, when pasting in either BANDinput or ReaxFFinput these lattice vectors will also be pasted. This makes it very easy to copy a slab from BANDinput to ReaxFFinput.

You can also copy some molecule geometry in XYZ format (for example from an ADF output file), and use the Paste command in ADFinput to get it there. This is equivalent of using the Import Coordinates command, but you do not need to select a file.

Finally, if the paste command does not recognize any of the options above, it will try to interpret the text to paste as a SMILES string using OpenBabel. Thus you can simply copy a SMILES string from a web site, and paste it in the ADF-GUI molecule editor. Note that the interpretation of SMILES strings does not always work correctly using OpenBabel.

View Menu

The 'View' menu is also shared by all modules providing a 3D view of your molecule. It will contain at least the following commands:

Reset View

When you use the 'Reset View' menu command, the translation, zoom and rotation settings will be adjusted such that the entire molecule is visible. The center of your molecule will be the new rotation center.

Use it for example when you translate the molecule 'out of view'.

View Direction

Rotate the molecule such that you view along the specified axes.

Parallel Perspective

Check to get a straight parallel perspective. This will not take the distance into account, and may be useful with crystals for example.
Fly to selection

Zoom to the center of the current selection (or of the whole molecule if nothing is selected). The zooming occurs ‘real life’, as if you are flying to that point. The zoom point will be the new center of rotation.

Align screen

First select three atoms defining a plane (thus, not three atoms on a line ...).

Next, use the ‘Align Screen’ command to rotate your molecule such that the plane defined is parallel to the screen.

Mouse as

Determine how your mouse works:

- Trackball: you rotate etc by dragging around the screen. This is the default, and most intuitive, mode.

- Joystick: you rotate etc by pressing down a mouse button off-center, and keep it pressed down. Your molecule will rotate, translate etc in the direction of your mouse button (with respect to the center of the drawing area). Since the press-and-keep-down conflicts with pop-up menus, they will be disabled.

Anti-alias

Use the anti-alias technique to improve the quality of the pictures. Especially sharp edges will look smoother.

It works very well, but is rather time-consuming to calculate. As a result everything will be very very slow. For that reason we advise you to first increase the resolution of the picture to be saved. Next, only when you want to prepare an extremely high-quality picture for a presentation (and have plenty of time ...), you might in addition turn on anti-aliasing.

As anti-aliasing works my mixing in the background color to get smooth edges, you cannot change the background color in a saved picture. If you would wish to do so (for example, make the background transparent), you should not use anti-aliasing.

Axes

Show axes. As is indicated, the red line is the X-axes, the green line is the Y-axes, the blue line is the Z-axes.

Molecule Ball & Sticks

Molecule Resolution

Set the resolution of the molecule display (the number of triangles used to represent the atomic spheres and the bonds). If you have a big molecule and a low-end graphics card you can speed up display by choosing 'Low'. For high-end graphic cards you might not see a significant difference.
**Balls And Sticks**

Show the molecule as balls and sticks

Using the regions panel you can set this option per region.

**Sticks**

Show the molecule as sticks only (that is, with the atoms hidden).

Note that this will make editing much harder as you cannot click on an atom to select it.

Using the regions panel you can set this option per region.

**Wireframe**

Show the molecule as a simple wireframe only.

Note that this will make editing much harder as you cannot click on an atom to select it. However, the display is much faster so it is efficient to use for big molecules.

Using the regions panel you can set this option per region.

**Show Bond Type**

Use different graphics for single, double, triple and aromatic bonds if checked. If not, all bonds will be visualized as a single bond no matter what bond type it is.

**Color Bonds By Atoms**

Bonds will have a color gradient, running from the color from one bond atom to the color to the other bond atom.

**Bigger, Smaller**

Change the size (radii) of the balls and sticks used to display the molecule. Note the convenient shortcuts (control - and control +, or command - and command +).

**Background**

Select the color of the background.

**Atom Info (name, charges, etc)**

Use the checkboxes to select what info per atom to show. The atom name, and possibly some other things.
When a .t21 result file is open in ADFview or ADFmovie, some scalar properties might be available. For example, you can show the Mulliken Charge in that atom info label, some other atomic charge, or the electrostatic potential at the nucleus. The list of available properties will automatically be constructed, depending on the kind of information in the result file.

In ADFinput, after running a Mopac also the Mopac charges may be selected.

The command will be applied to the current selection, if any. If nothing is selected, it will be applied to the atom on which the user clicks.

**Color Atoms By**

Select the property that will be used to define the atom colors. If you use a scalar property, you can optionally set the scalar range to be mapped to colors, and you may select to show a color legend.

**Atom Radius From**

Select the property that will be used to define the atom radius. If you select a scalar property the absolute value of that property will be used. Next it will be clipped to the min - max value as defined in the preferences (via the SCM menu).

**Geometry Info**

Depending on the number of atoms selected, subcommands are available to show distances and angles, or to hide them.

**Info Style**

Select the size and colors of the Atom Info labels.

**Hide Hydrogen Atoms**

Hide all hydrogen atoms (they will still be present, just not visible)

**Show Bonds To Hidden Atoms**

Show or hide bonds to hidden (hydrogen) atoms. If they are hidden, they will still be present, just not visible.

**Show Unit Cell**

In some modules, this command will be available to show the unit cell. Obviously only when a unit cell has been defined.

**Periodic**

Show periodic repetition of a unit cell. This will never be enabled for the ADF-GUI.
Popup Menus

In some modules you can get a popup menu by right-clicking on an atom or bond, or by left-click-and hold on an atom or bond. In the popup-menu you will find the same menus as on top: viewing atom info and more. They behave identical to the same menu on top.

The commands available in the pop-up menu depend on the module you are using.
ADF-GUI modules

ADFjobs

Introduction

ADFjobs is a utility program ($ADFBIN/adfjobs), which enables ADF users to easily manage their ADF (and other) jobs. You can use ADFjobs to keep an overview of your jobs, to quickly access old jobs, to run jobs locally and remote, and keep track of running jobs.

Finally, it provides a convenient launcher of the other ADF-GUI modules.

Thus it is a mixture between a file manager, a job manager and a launcher.

Important: If running on remote machines, users (and ADFjobs) should be able to use ssh to log in to the remote machine without ever needing to enter a password. Please check the GUI Installation Guide for more details if needed.

After starting ADFjobs, it will scan all files in the directory in which it is started. ADFjobs will consider all files that have the same name except their extension to be part of the same job.

Starting ADFjobs

If you have installed the ADF package correctly, the adfjobs command is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFjobs program with the following command:

```
adfjobs [dirname]
```

The dirname (directory name) is optional, ADFjobs will use the current directory when nothing is specified.

An alternative method to start ADFjobs: select the Jobs command from the SCM menu, or use the Run command in ADFinput. ADFjobs will always start automatically when needed.

If you are using a MacOS X, ADFjobs will automatically be started when you start ADFLaunch.

Under windows you can start ADFjobs by double-clicking the icon on the desktop.

Use as Launcher (ESC key)

You can use the SCM menu in ADFjobs to launch any of the other ADF-GUI or BAND-GUI modules.

When you have a job selected, the SCM menu in ADFjobs will open the selected job using the module that you select in the SCM menu.

To launch any of the ADF-GUI or BAND-GUI modules without opening an existing file make sure you have not selected a job in ADFjobs. If a job already has been selected, click somewhere in white space on the bottom, or somewhere in empty space in the selected job (thus not on the name, queue, or one of the icons). The selection will be cleared.
Alternatively, you can clear the selection using the Esc key, or by using the Clear Selection command from the Job menu.

Finally, you can launch and of the ADF-GUI or BAND-GUI modules without opening the selected job by pressing the control key, and select the proper module from the SCM menu while keeping the control key pressed down. This works not only in ADFjobs, but in all modules.

**Queues**

A queue tells ADFjobs how to run the selected job: where (possibly on a remote system!), how and by whom.

In the Queue menu you see a list of queues. Select one of them to use that queue when running the selected jobs.

If you have configured queues for remote machines, you will be able to use those remote machines just as easily as your local machine. ADFjobs will take care of copying files to and from the remote machine. It will also start or submit your job, and inform you of the progress of your job.

For each job, you can specify some extra text in the options field next to the name of the queue (with the gray rectangle around it). How this text is used depends on how your queues are set up. For example, the Interactive queue uses it to specify the number of tasks to use in your job. For batch systems, it might be the number of nodes to use, or some time limit or batch queue name.

When starting ADFjobs the first time, you will see the Interactive and the Sequential queue. Both will run jobs on your local machine, using as many tasks as possible. You can enter a number in the options field of the job (with the gray rectangle) to set the number of tasks use explicitly.

Note that the user can override the queue settings per job via the 'Job Details', but this is normally not needed.

Via the GUI Preferences, you can also configure ADFjob to automatically pick up queues stored in a central location. They need to be defined once, and any ADFjobs user can import them. Such queues are called 'Dynamic queues'.

**Interactive Queue**

When you run ADFjobs for the first time, it will make sure that an Interactive queue exists. If not, it will automatically create such a queue for you.

When you use the interactive queue to run a job, your job will run immediately on the local machine. Thus you can run many jobs at the same time.

To specify how many tasks to use, enter a number in the options field. If you leave it empty all cores will be used.

As you could be overloading your machine it may not be what you want, but it is great if you have some job running and want another small on to run at the same time. Another use would be to run several single-core jobs on a multi-core desktop machine at the same time.

**Sequential Queue**

When you run ADFjobs for the first time, it will also make sure that a Sequential queue exists. If not, it will automatically create such a queue for you.
When you use the Sequential queue to run a job, your job will run interactively on the local machine as soon as no other job is running. Thus you can give the run command in ADFjobs for many jobs at the same time, but they will actually run one after the other.

To specify how many tasks to use, enter a number in the options field. If you leave it empty all cores will be used.

Normally, this is the most convenient and efficient way to run jobs on your local machine. For that reason it is the default queue (unless you change that).

Setting up your own Queues

You can define a queue in several ways:

- **Queue → New...** based on one of the included example queues,
- **Queue → Edit...** change details of a queue (or make a new one if you change the queue name as well),
- **SCM → Preferences → ADFjobs → Dynamic Queues** import queues stored on some central system

When using the **Queue → New...** command, you can select what configuration to start with:

- **Interactive**: make a new Interactive queue. For example, to make a special version that will force your job to use only 1 task.
- **LSF, PBS, SGE**: make a new queue that will submit your job to the selected batch system. The configuration of these batch systems can be quite different. The included examples should serve as an example only, you will need to fix the details. In the included examples the options field is used to specify the number of nodes to be used.

When using the **Queue → Edit...** command, you select what queue configuration to edit.

Using either of these commands, a dialog will appear requesting you to set the details of the queue you are creating (or modifying).

Remote host

Name of the machine on which you wish to run your job. You should be able to connect to that machine using ssh, and the host name as specified. If you wish to run on your local machine, leave this field empty or specify localhost.

Remote user

The username that you need to specify in the ssh command, if any. Typically, this is your username on the remote machine. If you have configured ssh to log in on your remote machine without specifying a user name, you can just leave this field empty.

Remote job directory

On the remote machine, ADFjobs needs to set up your input files and run script, and needs to collect the results. For that purpose ADFjobs will make its own directories within the directory you specify. A typical value would be something like $HOME/jobs.

Run command

The command on the remote machine to be executed.

$job will be replaced by the full path to your job script on the remote machine.
$jobname will be replaced by a jobname based on the value of $job, but truncated and with spaces removed.

$options will be replaced by the contents of the Options field.

The Options typically will be used to specify the number of tasks, a time limit, or a batch queue name.

If you use the run command to submit a job to some batch system, it should return a number. This number will be assigned to $jid, and may be used by the kill and job status commands.

To run interactively, just enter "sh $job". To submit your job to a queue, specify the submit command (for example, qsub, or some other special submit tool). For example, check the pre-configured queues for Interactive and batch systems (via the Queue → New... menu command).

The job script that is automatically generated accepts an optional parameter. This parameter is 'eval-ed' at the start of the script. Thus, you can use it to set environment variables (like NSCM) or other things.

Use Local Batch

If yes, jobs will be queued on the local machine. Only one job will be running at a time. This is set for the Sequential queue (which is default). Currently this value is ignored when the job will be queued or run on a remote system.

Kill command

The command to use to kill a queued or running job. In this command $jid will be replaced by the job id (from the output of the run command), or by the process id. For interactive jobs, killall $pid should work fine. This killall is actually replaced by a special script that takes care to kill adf and all child processes.

Job status command

This command will be used to determine if a job is still queued or running. If a job is no longer queued or running, it should return an empty string. Anything else will server as indication that the job is alive. For interactive jobs ps -p $pid | grep $pid works fine.

System status command

The command to use to determine the system status. This might be uptime, or some qstat command for batch systems.

Prolog command

The command to execute at the beginning of the job script. This will be used to set up the environment properly. For example, you would source a script file to set all environment variables for ADF like ADFHOME, ADFBIN etc. This is especially important if you are working with different versions of ADF at the same time. Note that the job script is started using /bin/sh, so you should use sh-like syntax (an not csh-like).

Epilog command

This is the command to run at the end of the job script. You can use it to copy save result files, or to perform some cleanup action. Again, use sh-style syntax.

Logfile extension

The extension for the logfile, should normally be logfile. If you use ADFjobs for other programs than ADF, you could specify a different value to monitor the progress of your other program.
Dynamic queues

Dynamic queues are updated automatically when ADFjobs starts.

ADFjobs will check with the hosts that you have specified in the Preferences (via SCM → Preferences → ADFjobs → Dynamic Queues) if queues are defined. If so, they will be imported and added to the queue menu.

On the remote hosts listed, ADFjobs first checks the $SCM_QUEUES environment variable. If it is set, it will import the queues defined in the $SCM_QUEUES directory. If it is not defined it will try to import queues from $HOME/.scm_gui. This is the location where ADFjobs stores the queue information.

To define the dynamic queues, first figure out what queue settings you (and/or others) want to use. You can do this by configuring a normal queue with ADFjobs as described. As dynamic queues typically will be used by many users, you should not specify a username (unless you want all users to use the same account on some system). Make sure it works properly.

Next make a directory on the remote system where you want to store the dynamic queue definitions.

Set the SCM_QUEUES environment variable system wide on remote system for all users.

Locate the files that define your queue: you can find these files in the $HOME/.scm_gui directory. They have the name of the queue, with a .tid extension, and are plain text files. Next, copy these files into the $SCM_QUEUES directory on the remote system. Make sure all users have permissions to read the $SCM_QUEUES directory and the files in it.

Users need to use the SCM → Preferences → ADFjobs → Dynamic Queues command to let ADFjobs know it should try to get the dynamic queues from your server.

Note: the server that stores the dynamic queues need not be the same machine on which the jobs will run.

Note: the ADFjobs user needs to have access to the server via ssh

File and Job listing

ADFjobs has one main window that displays a list of jobs.

A job is actually any file, and ADFjobs groups files together to what ADFjobs considers 'jobs'. One job is a set of files with identical names except for their extension. In the job list you see this common name.

Job elements

For each job the following is presented, from left to right:

  Job icon
  Job details toggle
  Job name
  Queue name
  Options
  Status icon
The job icon tells you what kind of job it is: ADF, BAND, some other script that you can run, or something unknown. The icons also come in two main versions. Depending on the style, blue and gray, or blue dot and black cross. The 'blue' icons signal 'runnable' jobs, that is, jobs that contain a file with a .run extension. ADF jobs assumes that this is some kind of shell script, and that it can run this script (either on the local or on some remote machine). Gray jobs are not runnable, no .run file is present.

The job details toggle is a button that you can click to show or hide more details about the job: Job details, Local files and Remote files. Each of the three sections may be open or closed, you can again click on the corresponding triangle to toggle this state.

The job name is just the name of the group of files without the extension.

The queue name is the name of the queue that you have set for this particular job, if any. If you select a queue from the Queue menu, that will specify the queue name here. You can also edit this name, but only when you are changing the job details for this job, and only when the job is currently not running.

The Options field is a text field that you can use to specify some details to run a job. For example, a time limit or the number of CPUs to use. The meaning depends on the Run command specified with the Job Details, in the included examples it typically is the number of CPUs or nodes to use.

The status icon tells you if the job is a new, queued, running, ready or terminated. It also shows you if the job has finished with an error or warning.

**Job status (including WARNING and ERROR info)**

The status icon is the icon on the right side of the job. It tells you if the job is a new, queued, running, terminated, ready, ready with a warning, or ready with an error condition.

The warning and error condition is determined from the logfile of the job. If it contains a WARNING, the icon will display a warning triangle. If the logfile contains ERROR, the status icon will change into a red stop sign.

Move with your mouse over the job, and a balloon will popup with details of the error or warning condition. Obviously, when a job has ended with an error you will normally not have useful results. If a warning has been printed, you should make sure you understand the warning, and that the ADF did perform the calculation that you intended.

**Selecting**

You can select one or more jobs with:

- left click - select that job
- shift left click - select a range of jobs
- right click (or control left click) - toggle that job to be selected or not selected
- click on the search icon - clear the selection

Note that the SCM menu depends on the selected job: if an ADF job is selected, the ADF-GUI modules will be shown. If a BAND jobs is selected, the BAND-GUI modules will be shown. If nothing is selected, all modules will be shown.

To clear the selection, press the ESC key, use the Job → Clear Selection menu command, or click somewhere in white space on the bottom or in the selected job (thus not on the name, queue, or one of the icons).
Changing directories, open a job, change a job name

If ADFjobs finds directories in the current directory it will show them, with a folder icon. To change into a directory, just click once on the folder icon. The icon with directory name ".." means the parent directory (one up in the tree structure).

If you open a job, by a double click (most conveniently, double click on the Job icon) it will be loaded in another ADF-GUI module. If a job is running, the logfile will be shown, otherwise ADFinput or BANDinput will be used to display the job.

To change the name of a job, just click on the job name while the job is selected. It will become editable. When you change it, all local AND remote files will be renamed to match the new name of the job.

Filtering

You can select what exactly will be shown in this window with the Filter menu. Also, you can change the order using the Sort menu. Finally, by typing text in one (or both) of the fields at the bottom, next to the magnifier glass, you will filter out only those jobs that match the text (job name or queue name) that you type. This is very convenient if you have a directory in which you have collected many jobs.

Job details

The Job Details section shows you exactly what settings ADFjobs will use to run your job. They are set by the Queue selected for this job. If you wish, you can make changes here that will override the settings specified by the queue.

For a description of the options, see the section on how to define a queue. The options are identical.

The information is stored in the .pid file from the job.

Local files

The local files section lists all files that ADFjobs found. They all have the same name (the name of the job), and different extensions. Here you can see what files belong to a job, including modification date and time, and the size of the files.

Double clicking on some of the extensions might open that particular file, depending on your operating system.

Double clicking while holding the control key will open the file as a plain text file. It is your responsibility to decide if this makes sense.

One useful application is double click on the .run file. This will open the .run file in a text editor, depending on your operating system. In this editor you can actually make changes to the .run file. When you save it this modified run file will be used when you run the job. The .job file will be overwritten, thus you need to change the .run file if you wish to make manual changes.

Most files will open in the proper ADF-GUI module. If you prefer to open a file in a text editor (if possible), keep the control key pressed-down and double click on the file.

Within the local files you may also find a directory called 'results'. This will be created when result files are present other then the standard result files. For local jobs they will always be present, for remote jobs it will be created when using the Transfer from Remote command. The EDITOR environment variable determines what editor will be used, if present.
Remote files

This is a similar list of files as the local files list, but these files reside on a the remote machine as specified in the job details. If you are preparing a new calculation it will be empty. When a calculation is complete, it will show all the result files on the remote machine.

At the top of the list the name of the directory in which the files live on the remote machine is shown.

Change job name

To change the name of a job, just click on the job name while the job is selected. It will become editable. When you change it, all local AND remote files will be renamed to match the new name of the job.

Menu commands

SCM Menu

The SCM menu can be used to get to the other GUI modules. Note that it also contains the Preferences menu, that you use to start the GUIprefs module. You use this to set preferences for all GUI modules, including ADFjobs.

File menu

New Directory

Make a new directory. It will always have the name 'Untitled'. You can change the name by clicking twice on the name (or once if it is already selected), and typing the new name.

Delete Directory

Delete the selected directory. It must be empty before you can do this.

Version Info

This will show you exactly what version of the ADF-GUI you are using.

If reporting an issue with SCM support, this will be important to identify what version you are using.

Check For Update

Contact the SCM web site, and find out if there are any newer versions matching the version you are using.

If you are using a normal release, only normal releases and ‘fix’ snapshots will be considered.

If you are using a development version (for example one of the snapshots), the development snapshots will be checked.
When a new version is available, you can optionally download it. You will need to install it yourself.

Quit

Quit ADFjobs. Note that ADFjobs takes care of updating logfiles from running jobs, so if you close ADFjobs these files will not be updated automatically any more.

Edit menu

This menu contains the usual menu command for text editing. The commands work only for text editing, not for anything else.

Job menu

Run

Run the selected job. If no queue has been specified, ADFjobs will propose to use the Default queue.

The job will run in a new, empty directory. At the end of the run files might have been produced by the job. These will be moved to the results directory (jobname.results). The files that you normally need are currently moved out of this directory and indicated by extension (jobname.logfile and so on). To get the results directory from a remote system you need to use the ‘Transfer from Remote’ command in the Job menu.

The job that actually will be run is created by ADFjobs each time you use the Run command. This is done by taking the .run file, and put some commands at the start and end of it. These commands take care of making empty directories and so on, and of copying result files back. The resulting script will be saved with a .job extension.

Thus the .job script is the one that is actually executed, not the .run file. You can make changes to the .run file manually if you wish, and ADFjobs will include them in the new .job file when you use the Run command. The .run file will not be overwritten by ADFjobs. Note that ADFinput will overwrite the .run file if you use the Save command (or the Run command within ADFinput which does a Save first).

Kill

Stop a running job, or remove it from the queue if queued with a batch system.

Transfer To Remote

Transfer all files belonging to this job to the remote machine. Normally you do not need to do this manually, ADFjobs transfers the files that are needed automatically.

Transfer From Remote

Transfer all files belonging to this job from the remote machine to the local machine. Normally you do not need to do this manually, ADFjobs transfers the files that are needed automatically.
Delete

Delete all files belonging to the selected job, locally and possibly remotely (ADFjobs will ask for this).

Delete Remote

Delete all files belonging to the selected job, on the remote machine only. You typically will use this to clean up on the remote machine.

Generate Job Script

Generate a job script (.job file) for the selected jobs. The .run scripts should already be present (normally they are generated by ADFinput or BANDinput). The resulting .job scripts should be complete scripts that you can copy and execute on remote machines yourselves. The .run scripts are bare-bones scripts that will fail in many situations.

Generate Test Job

Generate a job script that you can execute to verify your ADF set up. It checks environment variables, license and more. You can study the output to get an idea of what the problem is (if any). Alternatively, SCM support might ask for this output in case of problems.

Clear Selection

Make sure no job is selected. This is especially useful when using the SCM menu to start one of the GUI modules.

Refresh List

Force ADFjobs to scan the current directory again.

Reset

Remove all job information as added by ADFjobs. Normally never needed, it is an indication of a bug in ADFjobs ...

Queue menu

New...

Create a new queue. You can select from one of the included templates, and modify it as needed.
Select an existing queue using the submenu, and change it as required.

When you run a job that already was using the queue you changed, it will automatically adjust its settings to the new values as present in the queue. However, if you made job-specific changes to the job-details these will not automatically be overwritten.

Delete

Delete the queue you select using the submenu.

Set Default

Use the submenu to set the default queue to use when the user uses the Run command and no queue (or job details) has been set yet.

Restore Queue Configuration

Delete all queues, and restore this information to the clean state as if you install the ADF-GUI for the first time. This means that all queues that you have defined will be lost. Dynamic queues will not be lost as these are located on some remote system.

Status

Show the status window, collecting the information from the System Status commands as defined for all queues. Status pertaining to the same host is grouped together for easier reading.

Queue name

A list of queues that you have defined. If you select one of them, its settings will be applied to the selected job. Dynamic queues will have a name that starts with a ">".

Use the Preferences command from the SCM menu (SCM → Preferences → ADFjobs → Dynamic Queues) to tell ADFJobs on which machines to look for dynamic queues.

Sort menu

Define the sort order to be used while displaying jobs. Directories will always be shown first. Time is the last modification time of any of the files that make up a job. The other sort fields should be evident ...

Filter menu

Limit the kind of jobs (and directories) shown in the job list. Checked items will be visible.
Tools menu

You can use the Prepare tool to set up batches of jobs. For example, first set up an ADF calculation with your preferred basis set, XC potential and so on using ADFinput. Next, use the Prepare tool to generate a batch of similar jobs, but for different molecules (taken from .xyz files for example). Or you could set up a calculation for your molecule, and generate a set of jobs with different XC potentials and / or integration accuracies.

The Reporting tool is to generate a report of one or more calculations. This report will contain the information that you select when you define a 'report template'. Most of the properties that have been saved to .t21 will be available. And you can generate images as will (like HOMO or SCF density). These results will typically be collected in an HTML table: one row for each molecule, and one columns for each property.

A report template defines what information to put into the report.

Prepare...

When you choose the Prepare... command from the Tools menu a dialog box will be presented that you can use to specify how to generate a set of jobs.

Three main list fields are presented: the Run field, the coordinates field, and the input options field. In each of these lists you can specify multiple options. When pressing 'OK' ADFjobs will generate the jobs by combining the options in all possible ways.

Run list

Select one or more .adf files to run. A .adf file is just a calculation that has been set up using ADFinput before. Alternatively, one may use one of the predefined .adf files as present in the pull-down menu when you press the '+' button. To add a .adf file, use the pulldown menu, or specify a file name in the text field and press return. You may use wild card in the text field, so the default value (*.adf) will expand to all .adf files in the current directory. To remove something from the list, select it and press the '-' button.

Coordinates list

When this list is empty, the molecule as found in the .adf files will be used. When one or more sets of coordinates is present in this list, the molecule in the .adf file(s) will be replaced by the molecules as defined in the coordinate files. You may use .adf files, .xyz files, .t21 results files, .mol files, .pdb files or whatever other format ADFinput can use with the 'Import Coordinates' function. By listing multiple files here your .adf files (that you listed in the Run: list box) will all be executed with each of the molecules in turn. Thus, if you specified two run files (for example a Single Point calculation, and a Geometry Optimization), and three molecules, you will end up with 6 jobs.

Input options list

In this list you may define alternative input options. The corresponding input options in the .adf file will be replaced by the values that you specify here. So if you specify two different basis sets, each job will be replaced by two new jobs, one with each basis set that you specify. You may also specify other things, like integration accuracy and so on. If you specify only one value, that value will be used in all jobs. If you specify multiple values (by repeatedly adding the option) you will generated multiple jobs.

The text field may be used to add additional keywords, or replace existing ones, with the value specified. These options will be added to the list of options by pressing return in the text field. The values will be used as the '-k' argument to the adfprep command. For detailed information about this please check the adfprep documentation.

Produce jobs options
The final fields will tell the prepare tool where to generate the jobs (the directory is relative to the current
directory, and will be created if it does not yet exists). Also one big job will be created that is just a
concatenation of all the individual jobs. When running interactively it might be more convenient to run this
job instead of all the individual jobs. The results should be identical, the big job will produce files that look as
if they have been produced by the individual jobs.

**New Report Template...**

Select this command from the Tools menu to generate a new report template. A report template defines
what information should be put into the report. The template name will be used in the Tools menu to identify
this template.

After selecting the command, a dialog box will appear with many options. Just check the options for the
information that you wish to collect in your report. Note that you can also include images (of orbitals, and so
on) in the report.

If you wish to include something that is not present in the dialog, you can use the last field: Extra ADFreport
command line options. Whatever you specify here will be passed to adfreport to generate the report. This
allows you to get any information that is available on a .t21 result file into your report. Check the adfreport
documentation for syntax details.

**Edit Report Template...**

Use this command to change an existing report template. You will get the same options as with 'New Report
Template'.

**Delete Report Template...**

Delete a report template that has been made before.

**Build ... Report**

Select one or more jobs. Next use the 'Build ... Report' command to actually generate the report. Note that
the ... will be replaced by the name of the report template.

A dialog box appears that allows you to save the report with a name that you like. When a report with the
same name already exists, you will be asked if you wish to overwrite it. Click Yes to replace it or to append
information to it, click No to avoid changes to the existing report.

When the report file already exists you next will have two options: add the information at the end of the file
(thus extending the existing report), or replacing the old report.

Finally, the report will be generated. If it is saved using the .html format (the default), the resulting report will
immediately be shown using a browser.
Update Last Report

This command allows you to update the last report: use the same report file, and the same report template, but apply it to another job. This might even be in a different directory. This allows you to collect information from jobs a few at a time.

ADFinput

Introduction

ADFinput ($ADFBIN/adfinput) enables ADF users to easily create ADF jobs. You can use ADFinput to define your molecule (geometry), pre-optimize it, and to set details of your ADF job using an easy-to-use graphical user interface. ADFinput will generate the complete job script for you. This script takes care of running ADF and property programs as required. You can also use ADFinput to run these script files, though the actual running is handled by ADFjobs.

You can also use ADFinput to drive a number of external programs: Mopac (if installed), DFTB, OpenBabel (obminimize, for minimizations using a force field like UFF) and MM (the newmm code included with ADF). All of these can be run interactively, and the geometry in ADFinput will be updated automatically. You can also view the output of these programs if you are interested in the details.

Starting ADFinput

If you have installed the ADF package correctly, the adfinput command is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFinput program with the following command:

```
adfinput [filename]
```

The filename is optional. ADFinput only handles files that were created by ADFinput before (which have a .adf extension) and PDB files (with .pdb extension).

An alternative method to start ADFinput: select the Input command from the SCM menu, or use ADFjobs to start ADFinput.

Under windows you can start ADFinput by double-clicking the icon on the desktop.

Panels

The ADFinput window has two main areas: on the left is the molecule editor, and on the right are the panels.

You use the molecule editor to create or display your molecule. It can also display some calculation results, like charges calculated by Mopac.

The panels on the right allow you to set up your ADF calculation, as well as perform calculations using other programs. You can switch between different panels using the pull-down menu across the top of the panels. All panels relate to ADF, except a few that set up external programs. These are grouped together and are named by the alternative program that they support.
**Mopac, DFTB, MM, OpenBabel**

After selecting the Mopac, DFTB, MM or OpenBabel panel you can set up details of that particular calculation. DFTB, MM and OpenBabel should work without further actions, for Mopac you will need to install Mopac to the default location. Please check the GUI Installation Guide for details.

All these panels have a Show Output option. If that is checked, the output file of the calculation will automatically be displayed.

When the geometry is changed by any of these programs, the geometry of your molecule will automatically be updated. This makes it easy to follow a geometry optimization using any of these methods.

You will also see the actual run script that ADFinput uses to start the calculation. This run script is constantly refreshed to match changes in your molecule or in your input options. If you UNcheck the 'Run script: Auto update' check box the script will no longer be updated (until you check the box again). This allows you to edit the run script and make your own changes.

The 'Add to job' option allows you to run these calculations as part of your job. Thus, not interactively from ADFinput but just like any normal ADF job. Normally a job will also execute ADF. If you do not wish this, be sure to check the "Skip ADF" box.

**ReaxFF**

With the ReaxFF panel, you can run your current ADF job (geometry optimization for example), but use ReaxFF to calculate the energies and forces. This can be used as a pre-optimization, provided that you have a proper force field.

No properties will be available, just anything to do with geometry optimizations (including transition state searches).

The use of ReaxFF requires that you have a license for ReaxFF as well as for ADF.

**Calculation Tabs**

When using Quil or QM/MM on the bottom of the panels a new line will appear with two or more tabs. These tabs determine to which calculation the usual panels refer. Thus, you might have two different ADF tabs (called ADF1 and ADF2 for example). Click on the ADF1 tab, and next all changes you make in any of the input panels will apply to the ADF1 calculation. Click on the ADF2 tab, and everything will relate to the ADF2 calculation.

Your Quil or QM/MM setup will determine how these different calculations will work together. To set up these details, there will also be a Quil or QM/MM tab.

**Menu Commands**

**File menu**

**New**

Same as quitting ADFinput and starting again without specifying a file name.
Open an existing ADFinput file or PDB file (with .adf or .pdb extension).

When you open a .adf file, and a matching and newer .t21 is found that contains changed coordinates, ADFinput will ask you if you wish to update the coordinates in the .adf file to match the .t21 file. You can use this, for example, to update your geometry after running a geometry optimization. Note that the .t21 might just contain the same molecule but reoriented to obey the symmetry requirements of ADF.

When you open a .pdb file ADF will read the geometry. It will also try to read protein information like residues and chains. In the Regions panel you will find extra options to deal with imported proteins. However, you can also use a .pdb file to import simple molecules.

Import Coordinates...

Use this menu command to import the geometry of your molecule from file.

You can also copy a XYZ-formatted geometry (for example from an ADF output file), and use the Edit → Paste command to import coordinates. When your geometry comes from another GUI module within the ADF package (ADFinput, BANDinput, REAXFFinput), you can also copy the structure in that module, and paste it in ADFinput. That will contain more information, such as bond information.

You can import coordinates from a .t21 file generated by ADF, from a .adf file as saved by ADFinput, or from a text file (for example, a .mol, a .xyz or a .pdb file).

If you import coordinates from a .t21 file note that the extension must be .t21. A name like 'TAPE21' will not work. Bond information will only be present when the .t21 file has been created using the ADF-GUI, version 2006 or later. If no bond information is not present, just the coordinates are imported and bonds will be guessed (and no distinction will be made between different kinds of bonds).

Importing from a .pdb file will also get the protein information (residues and so on).

Importing from a .adf file is straight-forward: both coordinates and bond information is present so you will get exactly what you saved.

Importing from a .mol file will also give you both the coordinates and bond information contained in the file.

Importing from a text file is rather flexible: ADFinput needs three real numbers next to each other. These will be interpreted as x, y and z coordinate. One additional integer or the abbreviation of an element is also needed to identify the kind of atom.

To be recognized as real, the real number must contain a '.' (dot), and at least one digit before or after the dot. Real numbers with exponents (E or D) are not recognized.

If an integer is used to specify the element (the nuclear charge), it may not contain a '.' (dot).

Bond information is not imported, even if present in your file (unless importing from a .adf file or a .t21 file). After you have imported some coordinates, ADFinput tries to guess the bonds between the imported atoms. It does this via OpenBabel when available. Guessed bonds might be completely wrong, or of the wrong bond order.

Z-matrix import (internal coordinates) is currently not available.

Directly after the 'Import Coordinates...' command the newly imported atoms are selected. This makes it easy to reposition them with respect to other atoms that may already be present, remove the automatically guessed bonds, or use other operations on the newly imported atoms and bonds.
Export Coordinates...

Export the current geometry as a simple space separated list of element name and xyz coordinates. The number of lines will match the number of atoms, with two additional header lines. The first header line contains the number of atoms, the second line will be empty. This might change in the future. No bond information is written to the text file.

You will be prompted to specify a file name.

Save

Save the current state of what is present in ADFinput. If you have not saved before, ADFinput will ask you to specify a file name.

Not only the .adf file will be saved, but also a matching .run file which is a run script corresponding to your input. If you are performing a fragment analysis also .adf files and run scripts for the fragments will be saved.

Save As...

Save the current state of what is present in ADFinput in a file with a name of your choice.

Not only the .adf file will be saved, but also a matching .run file which is a run script corresponding to your input. If you are performing a fragment analysis also .adf files and run scripts for the fragments will be saved.

Revert...

After opening a .adf file with ADFinput and making some changes, you can use the 'Revert...' command to undo all your changes. It is the same as quitting without saving, and opening the same file again.

Save Picture...

Save a picture of your molecule (only the drawing area with your molecule, no input options) in a file.

The format used to save your picture is determined by the extension of the file name you specify. If you do not specify a known extension, it will use the standard picture format as specified using the 'Default Picture Format' menu.

Default Picture Format

Use the submenu to select the format to use when saving a picture.

Note that this is just the default to use, the user specifies the format with the extension. When the extension is not recognized (or when no extension is specified) the default format will be used.

Picture Resolution

Use the submenu to select the resolution to use when saving a picture.
Run

Start ADF and / or property programs as selected in all the input options.

This is done by telling ADFjobs to run this job. If you have made changes in ADFinput, you will first be asked to save the changes. Just as the Save menu command, this will also save the run script (with the .run extension). Next your job is run by ADFjobs. Details will depend on your ADFjobs setup.

When a run is finished, if you still have the matching ADFinput window open, you will be asked if you wish to update the coordinates of your molecule with the most recent set of coordinates from the finished calculation. You can use this, for example, to import an optimized geometry.

Quit

Stop ADFinput, ask you to save changes if you made any.

Edit menu

The Edit menu has the standard Edit commands, see Standard Edit commands.

Additionally, in ADFinput the following commands are available.

Undo

Undo the last operation. It uses a stack of many operations, so you can use the Undo command repeatedly.

Redo

If you have undone some operation, you can use Redo to do it again.

Clear

Delete the current selection.

Group

The currently selected atoms and bonds will be grouped together. Once grouped, if you select any of the group members the whole group will be selected.

You may nest groups if you wish, the original group structure will be remembered.
**Ungroup**

Remove the grouping of the currently selected items.

If you ungroup a nested group, only the top grouping will be removed and you will recover your original groups.

**Set origin**

Translate all atoms such that the selected atom will be the new origin. If nothing is selected, the center of all atoms will be the new origin. If more than one atom is selected, the center of the selected atoms will be the new origin.

When symmetry is used, the origin will also be the origin of symmetry.

**Symmetry**

The symmetry menu gives access to the symmetry code as used in ADFinput 2008. Using it is somewhat complicated, and sometimes it does not work as expected. Starting with ADFinput 2009, a new symmetry code is included (Symmol). To use it, click on the Symmetrize button (the star).

To use the old symmetry code, you first need to define the point group that you want to use for your molecule. You do this by selecting the group name from the symmetry menu (initially the menu reads 'Nosym').

Next you need to define one or two operators for the selected group. In the symmetry menu you can see what operators you need to define.

Make sure that the (symmetry) origin of your molecule is set correctly (use the SetOrigin menu command).

1 atom selected: this defines the axis through center of molecule and the selected atom. This is the axis that will be used when you define a rotation axis. When you use it to define a mirror plane, the plane perpendicular to this axis through the origin of your molecule will be used.

2 atoms selected: defines an axis that will be used either as rotation axis, or as normal axis to a mirror plane through the origin.

3 atoms selected: defines a plane that will be used as mirror plane (shifted to the origin if required), or defines an axis for rotation (through the origin, in the direction of the normal vector of the plane).

Next you can use the symmetry commands:

Symmetrize: try to update the coordinates of the current atoms so that the molecule indeed has the required symmetry. Warning: if atoms are missing this will be resolved by moving equivalent atoms to the origin ...

Add symmetry equivalent atoms: generate all missing symmetry equivalent atoms to produce a molecule with the required symmetry. The existing atoms may be slightly moved to enforce perfect symmetry.
Mirror

Using one of the submenus of the Mirror menu you can mirror your molecule in either the XY, XZ or YZ plane.

The command applies to the current selection only, or to all atoms if no selection. Before performing the mirror operation, the molecule is translated such that the new origin will be the center of the selection.

Align

This menu contains several commands to align your molecule to the indicated axes or plane.

If you are aligning to an axes, you need to select which atoms to align. If you select one atom, the molecule is rotated around the origin such that the selected atom is on the specified axes. If you select two atoms, first the molecule is translated such that one of the selected atoms is on the origin. Next, the molecule will be rotated such that the other selected atom is on the specified axes.

If you are aligning to a plane, you need to select a plane to align. If you select two atoms, these will define the normal of the plane to be aligned. If you select three atoms, these define the plane to be aligned.

Typically the Align command will change your origin. You can always set the origin as you like afterwards.

Select menu

The Select menu contains commands that you use to select part or all of your molecule. They might use the currently selected atoms, for example to select atoms connected to the current selection. Some of the commands are also available within a popup menu that you get when you right-click on an atom in the molecule editor.

Select All

Select all atoms and bonds in your molecule.

Invert Selection

All atoms that are selected will be deselected, and all other atoms will be selected.

Select Molecule

Select all atoms and bonds that are somehow connected to the current selection.

Select Connected

Select all atoms that are directly connected (by one bond) to the current selection.
Select Within Radius

First select one or more atoms.
Next use this command to select all atoms within a given radius from the selection.

Select Atoms Of Same Type

First select one or more atoms.
Next this command will select all other atoms of the same type (that is, the same element).

Select All Bonds

All bonds will be selected.

Atoms menu

The Atoms menu contains commands that apply to the selected atoms. If no atoms are selected, typically they will apply to all atoms. The menu commands are also available within a popup menu that you get when you right-click on an atom in the molecule editor.

Delete Atom(s)

Delete the selected atoms.

Fuse Atoms

Fuse atoms that are very close together (in 3D space) to a single atom. If atom types differ, one of the types will randomly be chosen.

Change Atomtype

Change the selected atoms in some other type (select the type from the periodic system that appears).

Ghosts

Change the selected atoms into Ghost atoms, or turn Ghost atoms back into normal atoms. Ghost atoms are used to calculate the BSSE
Details (Color, Radius, Mass, ...)

Brings up a panel on the right-hand side that will allow you to set many atom details.

Since there are many possible details to see or adjust, they would not fit in the panel. So on top of the panel you will need to make a choice: atom type, screen radius, mass, nuclear charge, color, number of connectors, number of lone pairs, PDB name, Tripos and Amber details, and possibly a local Z or X axes.

If you move your mouse over the fields or buttons, a help balloon will give you details on what it is, and on how to change it.

Changing the nuclear charge will generate an alternative element (see the ADF Users Guide). Changing the mass is a simple way to calculate isotope effects with frequencies calculations.

Changing the type will generate a different type in your run script. The screen representation is not affected.

Atoms can also be changed into Ghost atoms, for BSSE calculations. This is done using the pop-up menu that you get by right-clicking on an atom (in the drawing area, not in the atom inspector).

For many of the options, you can change a value for all selected atoms at one time. Simply make the change for one of the atoms, and finish by pressing the return key. The same value will be used for all selected atoms.

Add Hydrogen

The 'Add Hydrogen' menu command will add hydrogen atoms to your molecule until every connector is connected. The number of connectors and the number of lone pairs determine the geometry. For example, the Oxygen atom has four connectors and two lone pairs in a tetrahedral arrangement.

The hydrogens will only be added to selected atoms, or to your whole molecule if no atoms are selected.

Remove Hydrogen

The hydrogen atoms will be removed from your molecule.

If you have selected part of your molecule, only hydrogen atoms in your selection will be removed.

Replace By Structure

The currently selected atoms will be replaced by the structure that you select via the sub-menus.

Bonds menu

The Bonds menu contains commands that apply to the selected bonds. If no bonds are selected, typically they will apply to all bonds. Some of the menu commands are also available within a popup menu that you get when you right-click on a bond in the molecule editor.
**Bond Lengths constrained**

When creating new atoms bonded to existing atoms, ADFinput will constrain the bond length to the textbook value.

If you do not wish this to happen, select this menu command to toggle this behavior.

**Add Bond**

Create a bond (if possible depending on the number of free connectors) between two selected atoms.

**Guess Bonds**

Guess the bonds between the atoms.

A simple algorithm will be used based on the distance between the atoms and the current number of bonds, connectors and lone pairs. It often works, but for complicated aromatic structures it might fail.

Only ADFinput uses the bond information. The ADF program itself does not use any of the bond information.

Bonds will only be guessed for the selected atoms, leaving the remaining part of your molecule unchanged. If nothing is selected, bonds will be guessed for your whole molecule.

**Remove Bonds**

Remove all bonds in the current selection, or in your whole molecule if nothing is selected.

**Bond Order**

Use the sub-menu to set the bond order of the selected bonds.

**View menu**

**Standard View commands**

See Standard View commands.

**Help menu**

The help menu provides an easy way to get to information about the ADF-GUI. It will start a browser on your local machine, and connect to the SCM web site to get information.

**Buttons and Tools**

The button bar contains a number of tools and buttons:
From left to right these have the following meaning:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tool</td>
<td>Used to select, and to rotate, translate or zoom (with modifier keys or mouse buttons).</td>
<td>Esc</td>
</tr>
<tr>
<td>Atom Tools</td>
<td>C-tool, O-tool, N-tool, H-tool, Cl-tool: atom-tools used to</td>
<td>C, O, N,</td>
</tr>
<tr>
<td></td>
<td>• create a C, O, N, H or Cl atom,</td>
<td>H, S, P, F</td>
</tr>
<tr>
<td></td>
<td>• change an existing atom,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• create bonds between existing atoms.</td>
<td></td>
</tr>
<tr>
<td>Element Tool</td>
<td>Atom-tools used to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• create any atom (from the periodic table that will pop-up),</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• change an existing atom,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• create bonds between existing atoms.</td>
<td></td>
</tr>
<tr>
<td>Structures Tool</td>
<td>Add a predefined molecular structure with one click or with a double click on an atom.</td>
<td>Spacebar</td>
</tr>
<tr>
<td></td>
<td>Spacebar reloaded the last used structure.</td>
<td></td>
</tr>
<tr>
<td>Symmetry menu</td>
<td>symmetrize your molecule using Symmol</td>
<td></td>
</tr>
<tr>
<td>Bond Type menu</td>
<td>• for new bonds</td>
<td>1, 2, 3 &amp; 4</td>
</tr>
<tr>
<td></td>
<td>• change selected bonds</td>
<td></td>
</tr>
<tr>
<td>Optimizer</td>
<td>Click to:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• start or stop the optimization</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• kill a running optimization</td>
<td></td>
</tr>
</tbody>
</table>

The currently selected atom tool, symmetry and bond type (if you are making bonds) will be shown if applicable in the status field in the bottom part of the drawing area. The currently selected tool will also be highlighted in the button bar.

**Getting and changing geometry details**

If you select 2, 3 or 4 atoms some geometry information will be presented at the bottom of the screen:

- 2 atoms: distance
- 3 atoms: angle
- 4 atoms: dihedral angle

Often you can also change the information displayed. The geometry of your molecule will be updated accordingly. This is not always possible: ring structures make it impossible since ADFinput does not know how to change other bonds and angles. In such a case you might temporarily remove a bond, fine-tune your geometry, and finally recreate the bond you removed. The planes of the plane angle are defined through (in order of selection) atoms 1, 2 & 3 and atoms 3, 4 & 5. The order of selection is important in all cases.

Alternatively, you can use the View → Geometric Info menu command to show distances and/or angles in the drawing area of the molecule. These are informative only, you can not use them to change the measurements.

**Keyboard shortcuts**

Many tools and menu commands have keyboard shortcuts associated.
For menu command shortcuts, the shortcut is listed in the menu. On most UNIX systems (including Linux) you need to use the control key together with some letter. On a Macintosh (running locally) you need to use the command key together with a letter.

The following table lists the other keyboard shortcuts. Just press the indicated key without any modifier keys:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Select-tool (end other tool)</td>
</tr>
<tr>
<td>C</td>
<td>C-tool</td>
</tr>
<tr>
<td>O</td>
<td>O-tool</td>
</tr>
<tr>
<td>N</td>
<td>N-tool</td>
</tr>
<tr>
<td>H</td>
<td>H-tool</td>
</tr>
<tr>
<td>F</td>
<td>F-tool</td>
</tr>
<tr>
<td>P</td>
<td>P-tool</td>
</tr>
<tr>
<td>S</td>
<td>S-tool</td>
</tr>
<tr>
<td>1</td>
<td>Set selected bond to type: single</td>
</tr>
<tr>
<td>2</td>
<td>Set selected bond to type: double</td>
</tr>
<tr>
<td>3</td>
<td>Set selected bond to type: triple</td>
</tr>
<tr>
<td>4</td>
<td>Set selected bond to type: aromatic</td>
</tr>
<tr>
<td>space</td>
<td>Structure-tool (using last structure used)</td>
</tr>
<tr>
<td>backspace</td>
<td>Delete selection</td>
</tr>
<tr>
<td>delete</td>
<td>Delete selection</td>
</tr>
</tbody>
</table>

**Pre-optimizer: SimpleMM**

Within ADFinput you can use a pre-optimizer to make a reasonable geometry starting with the geometry that you have drawn (or imported).

The SimpleMM optimizer is using a very simple and dumb forcefield like method. It more or less adjusts the bond lengths and angles to some hopefully reasonable value. This method is identical to the 2008 version of the ADF package. Advantages are that it is quick and always available. Disadvantages are that it is inaccurate, and produces nothing reasonable with clusters or metal atoms.

**Other ways to pre-optimize**

**DFTB**

This uses the DFTB program included with the ADF package. It seems to work very well and is reasonably fast. However, you will need to install the dftb parameter files yourself. And parameter files are currently only available for a small number of elements.

Please check the [SCM web site](http://www.scm.org) for more details.

When using DFTB as a pre-optimizer ADFinput will import the DFTB charges at the end of an optimization. You can visualize them as other scalar atomic properties.

To run DFTB as a pre-optimizer, select the DFTB panel on the right and press Run.
MOPAC

Another option is to use MOPAC as to pre-optimize. You need to get and install MOPAC yourself. See the GUI Installation Manual for details on how to install Mopac and have it work with ADF and the ADF-GUI.

When using MOPAC as a pre-optimizer ADFinput will import the MOPAC charges and bond orders at the end of an optimization. The bond orders are automatically used to set the bond details (bonds are created and adjusted based on the mopac bond orders). The MOPAC charges can be visualized as other scalar atomic properties.

The current ADFinput version has been tested with MOPAC2007 and later (from OpenMOPAC), and with MOPAC2006 (from Fujitsu).

To run Mopac as a pre-optimizer, select the Mopac panel on the right and press Run.

OpenBabel

Use obminimize (included with OpenBabel) to minimize the structure. By default this uses the UFF force field, but you can change this with the OpenBabel panel in ADFinput.

To run OpenBabel as a pre-optimizer, select the OpenBabel panel on the right and press Run.

Presets and Defaults

All input options have default values. However, the default values depend on the main task you have chosen, and on further properties you may select to calculate. ADFinput uses presets that are simply a collection of input values to be used together as defaults.

A preset may set all or just a few input options. After you have selected a preset (using the Preset menu on the main panel), fields that are set by the selected preset will be show with a green color.

ADFinput has a couple of templates for typical calculations (currently Frequencies, Geometry Optimization, IRC, Linear Transit, Old Linear Transit, Properties Only, Single Point, Solvent CRS, Strict, and Transition State Search). You may also define your own templates.

To switch from Task, we suggest you use the Preset menu. That way you will not only switch from task, but also set some other input options that are suggested for those tasks.

The Linear Transit preset will select the Geometry Optimization task. Next you will need to use the ‘Geometry Constraints and Scan’ panel to set up a series of constraint values to define the linear transit. This is a new feature, no need to switch to internal coordinates any more (they even will not work ...).

If you prefer the old style linear transit (with internal coordinates, and adjusting the Z-matrix to contain the coordinates you need and so on), select the ‘Old Linear Transit’ preset.

Use a Preset

Select the preset you want to use from the Preset menu, located in the main input options area. All or some input values will change to the values specified in the preset you select.
Revert to preset values

If you want to undo your changes and get back to the default values as specified in the current template, simply select the template again from the Template menu.

Color Code

The input fields use a color coding to warn you they have been modified:

- No special color: the field has its original default value.
- Yellow: the field has been changed by the user (only).
- Green: the field has been changed by the preset (only).
- Red: the field has been changed by the preset, and next by the user.

The pull-down menu that you use to switch between panels uses a similar color-coding to point you to fields that have been changed:

- No special color: all fields in the panel have their original default value.
- Yellow: some fields have been changed by the user.
- Green: some fields have been changed by the preset.
- Red: some fields have been changed by the preset, and some (possibly also) by the user.

Make your own presets

It is very easy to make your own presets, collecting all or a few default values for the typical jobs you like to perform.

When the SCM_TPLDIR environment variable has been set, ADFinput will look for user-defined presets (when starting up) in the directory $SCM_TPLDIR.

Thus, to use your own presets first set up your preset directory if you have not already done so:

  - make a directory in which to store your presets
  - set the SCM_TPLDIR environment variable to point to this directory

Next, in ADFinput (restart it if it was already running):

  - select the preset to start with (or None if you wish to start with an empty preset)
  - edit all the fields as you would like them to be stored in a preset.
  - select 'Save as (Full) Preset' from the Preset menu
  - specify a file name, ending with '.tpl'
  - click on Save.

If you now check your Preset menu you will find a new entry.

The name of the preset is the file name you have chosen, but without the .tpl extension.

The difference between a Full Preset and a 'normal' Preset is that a Full Preset will save all input options, and a 'normal' preset will save only the yellow or green fields (options that have been changed by the user or by the active template). A Full Preset is the same as a template from older ADFinput versions.

If you wish to store only fields that you have changed yourself in the preset, make sure you start with the None preset.
Defaults

The default values that are shown when you start ADFinput are generated as follows:

- Use the Defaults preset supplied by SCM
- Use the Defaults preset that the user has defined, if any
- Use the 'Single Point' preset

Thus, you can change the defaults by saving a preset called Defaults.tpl in your SCM_TPLDIR.

Calculation Tasks

There are several basic tasks (types of calculation) that you can choose from.

The currently active Task is shown on the main panel. It is a reminder only, you cannot change it there.

The easiest and recommended way to change the task is to use the matching Preset menu command. Not only will you change the task that way, but also some other parameters that normally need to be set to get reliable results. For example, to calculate reliable frequencies you will need to use a higher integration accuracy.

Alternatively, you may select the task from the task details panel. This panel will have a different title depending on the current task (Task: SinglePoint, Task: GeometryOptimization, etc).

Frequencies

Perform a frequencies calculation. The result of such a calculation is a hessian matrix, and a set of frequencies, intensities and normal modes (the IR spectrum). The hessian matrix may be used in subsequent calculations (for example, to help the search for a transition state).

ADF will calculate the frequencies analytically by default. You can also use a numerical scheme. To select this option use the 'Task: Frequencies' panel.

The Task: Frequencies panel contains many more detailed options. One recent addition is the possibility to calculate a partial hessian. To use this, just select the atoms that you want to be included in the hessian. Next, click the + button next to 'Partial Hessian' in the Frequencies Panel. A (possibly truncated) list of atom names will appear also in the panel. You can click on this list, and as a result all atoms included in the partial hessian calculation will be selected.

You can read more about frequencies calculations in the ADF Users Guide.

Geometry Optimization

Perform a geometry optimization.

ADF contains two different geometry optimizers. The most recent one is the default and should work more reliably in most cases. It is also very easy to specify constraints with this optimizer: go to the Constraints and Scan panel, and follow the instructions. With this new optimizer the linear transit (Scan) method is also much easier: it is just a series of constrained optimizations. In the Constraints and Scan panel you set how many points, and define the constraints to use. Thus it is very easy to select any distance or angle to use for your linear transit. No longer you need to switch to internal coordinates, and no longer you need to fix the Z-matrix to get the angles that you need.

A limitation of the new optimizer is that it will not work with Internal coordinates.
Alternatively, you can use the old optimizer. You can select this with the 'Optimizer Method' in the 'Task: GeometryOptimization' panel. The optimization is done using either Cartesian, Internal or Delocalized coordinates. You can select which coordinate type to use in the Coordinates panel.

You can read more about geometry optimizations in the ADF Users Guide.

**IRC (Intrinsic Reaction Coordinate)**

Follow the intrinsic reaction coordinate from a transition state.

You can read more about an IRC calculation in the ADF Users Guide.

**Linear Transit**

Perform a linear transit calculation. This is the old linear transit method, using the old optimizer. You need to select the coordinates to change using the 'Old Linear Transit' panel. Typically you will need to use Internal coordinates.

The new linear transit method is much easier to use: it is just a series of constrained geometry optimizations. To use this, select the 'Linear Transit' preset. This will activate the Geometry Optimization task. Next, go to the 'Geometry Constraints and Scan' panel, and set up the constraints and how to vary them during the linear transit.

The result of the linear transit calculation is a series of optimized geometries. You can use ADFmovie to show these. You may set up a new calculation with ADFinput starting from one of those geometries, for example to have a better starting point for a transition state search. To do this, select that geometry using ADFmovie. Next, use the 'Transfer Coordinates to ADFinput' to use that geometry in ADFinput.

You can read more about linear transit runs in the ADF Users Guide.

**Properties Only**

This task will set up a post-ADF property program calculation. Can only be used when the appropriate .t21 or, in some cases, .t10 file is present.

You can read more about the property programs in the Properties documentation.

**Single Point**

Perform a single point calculation (just one geometry).

**Transition State Search**

Perform a transition state search.

You can read more about transition state searches in the ADF Users Guide.
Structures

With the Structure tool (the button with the benzene like graph) you can quickly add molecular fragments to your molecule. When you have selected a structure from the menu, there are different ways in which they can be used.

Replacing an existing atom

After selecting a structure from the structure menu, the structure will replace any double-clicked atom. So, to change a methane into an ethane, select the methyl structure and double-click on one of the methane hydrogens.

You can add structures in the same way using the **Atoms → Replace By Structure** command. You can choose a structure from the sub-menu. The selected atom(s) will be replaced by the structure.

If you press spacebar, the last structure tool is selected again. You can then directly use it again by double-clicking on another atom.

Left-click in empty space

This will paste the structure at the desired spot. In most cases, one of the atoms in the structure will be selected. The selected atom, defined as the origin of the structure, is the same atom that will replace the atom that is double-clicked. When a molecule is already present, a potential bond will appear so that you can connect the structure to the molecule. If no atom in selected, it means that the 'replacing atom' is not defined, as is the case with the metal complexes.

If you press spacebar, the last structure tool is selected again. You can then directly use it again.

Metal Complexes

In the 'Metal Complexes' submenu of the structures menu, you will find many typical transition metal complex geometries that can serve as a good starting geometry. The dummy atoms, which define the geometry, can be conveniently replaced by structures from, for example, the 'Ligands' submenu.

The metal atoms cannot be used to replace an existing atom, since no atom is defined as the 'replacing atom'.

Dummy atoms and Multidentate ligands

Dummy ("Xx") atoms are treated a little different when used in structures. A dummy atom will not replace an existing atom when it is defined as the 'replacing atom'. Instead, the double-clicked atom will remain and will accept the bonds that the dummy atom had in the structure.

Thus, the dummy atom in the structure will be replaced instead of the atom that is double-clicked.

This behavior is utilized in the multidentate ligands, which can be added to a bare metal center. The dummy atom disappears and the ligand is bonded to the metal via the bonds that were previously located on the dummy atom.
Your own structures

You can make your own structure library very easily. First (before starting ADFinput) define an environment variable 'SCM_STRUCTURES'. It should point to some directory in which to search for possible structures. When you start ADFinput, the $SCM_STRUCTURES directory INCLUDING all subdirectories will be searched for structures. A structure is stored in an .adf file, you can just use any .adf file that you have created yourself.

The structures pull-down menu will have the same structure as the subdirectories within $SCM_STRUCTURES. One way to use this feature: set SCM_STRUCTURES to $HOME. Automatically any .adf file that you saved somewhere in your home directory will be found. However, if you have many files the start-up of ADFinput will be significantly slower since it needs to search all your files. In that case it is more convenient to make a special directory in which you put the .adf files that you wish to show up in the Structures menu.

To be able to actually use the structures as described earlier, it is necessary to define one of the atoms as having xyz coordinates (0,0,0). This will be the atom that will actually appear at the spot of the atom that is replaced by the structure. To do this, simply select the atom and use the 'Set origin' command from the Edit menu. Next, save the structure in $SCM_STRUCTURES. As mentioned above, dummy atoms behave a little different when defined in this way.

Molecule Editor Tricks

Selecting

You can make or change a selection using the mouse or using menu commands.

Making a selection with the mouse: see Selecting

Making a selection with a menu command: see Select Menu

Delete an atom

Select the atom (click on it), and press the Backspace key.

Delete a bond

Select the bond (click on it), and press the Backspace key.

Delete the selection

Make your selection, and press the Backspace key.

Make a bond

Take one of the atom tools.

Next click once on the first atom you want to connect. You will enter the bonding mode (the line to the mouse position from the atom you just clicked on will be your visual cue for the bonding mode).
Next click on the atom you want to make the bond to.

The bond will be created, and you will revert to the normal select mode.

**Make a bond, alternative method**

Select the two atoms that you wish to be bonded together.

Use the Bonds → Add Bond command.

**Change the bond type**

Select the bond or bonds to change. Next do one of the following to change the type of the selected bonds:

- press 1, 2, 3 or 4 for a single, double, triple or aromatic bond, respectively
- choose the required bond type from the Bond type pull-down menu
- use the Bonds → Bond Order command

**Move an atom (possibly perpendicular to the screen)**

First select the atom that you want to move.

Next, translate (middle mouse button, or alt left mouse button), but start with the mouse on the atom that you want to move.

If you wish to move the atom perpendicular to the screen: use the right mouse button (or command left mouse button) and move the mouse up or down). This is equivalent to zooming.

**Rotate or translate the selection**

First make your selection.

Next rotate, translate or zoom as usual, but start with the mouse in the selection. So if you click and drag the selection, ONLY the selection will be rotated or translated. If you click and drag anywhere else the whole molecule will be rotated or translated (actually, only your viewpoint).

If you 'zoom' the selection you are really moving the selected objects perpendicular to the screen (in or out the screen).

**Run Script**

Save your input using the Save or Save As ... menu commands.

Your input will be saved in a file with the name you specify, and at the same time a run script will be saved. It has the same name, but with '.run' appended.

This script contains only part of the commands to run your calculation, to keep it as simple as possible.

However, typically some more administrative things need to be done: make empty working directories, make some links to follow a running calculation, etc. This used to be done by the run script, but not any more. If you wish to use the run script yourself you are responsible of taking care of such details.
To run your calculation, use the Run command from the File menu. This will tell ADFjobs to run your job. Alternatively, you can switch to ADFjobs, select your job (that you should have saved from ADFinput), and select Run from ADFJobs Job menu.

ADFjobs will create the real job script (with .job extension). This is a .run script as saved by ADFinput, with the administrative things included at the front and at the end. As the .run script is simply included, you may edit it if you wish, and ADFjobs will automatically include your changed .run script.

If the environment variable SCM_RESULTDIR has been set, the job script will change into that directory. Next it will run from there, and all result files will be stored in that directory.

If the environment variable SCM_RESULTDIR has not been set, the job script will execute in the directory where it is started, and the result files will also be located in that place.

In ADFinput, the panel 'Files (Restart)' you can specify what files to save at the end of the run script.

By default, TAPE21 (result data), TAPE41 (grid data for visualization) and TAPE13 (checkpoint information) are saved.

### Input options remarks

#### Empty fields

Some input fields do not have a value from the default Preset. In those cases ADFinput does not specify the value, but leaves the value to be determined by the ADF program.

You can use the 'Explicit Defaults' preset to see the typical values. However, depending on details of your calculation the actual default used by ADF may be different.

#### Coordinates

The coordinates panel shows the coordinates corresponding to the molecule visible in the molecule display. You may edit the coordinate values here as well. Besides the values you can also change the order of the atoms, using the 'Move Atoms' buttons.

You may select to use Cartesian, Internal or Delocalized coordinates.

For internal coordinates you can currently only edit the values for bond lengths and angles, not the connection information. You can, however, change the order of the atoms. The Internal coordinates matrix will be recalculated each time the order is changed. The connection matrix will make as much use as possible of the actual bond information. If possible, vicinal dihedrals will be shown and groups such as methyls will be fully rotatable using one dihedral. If there are separate molecules present, the first atom on the second fragment will be connected to the first on the first fragment. This can be a useful trick to quickly define a certain distance.

The ordering of atoms in Cartesian, Internal and Delocalized coordinates is identical. Obviously the order is only important if you are going to use Internal coordinates.

If you will optimize the geometry (with ADF), the program will perform this optimization in the coordinate type you have selected here. Thus, the Cartesian, Internal or Delocalized pull-down menu is not only for display purposes, but determines the optimization method used.

By checking the checkboxes next to the coordinates you can freeze those coordinates during a geometry optimization. This works only with the old geometry optimizer algorithm.
You can select atoms using the coordinates panel as well as in the molecule pane. The coordinate lines for atoms that are selected will be highlighted in yellow.

**Spin and Occupation**

The spin and occupation panel allows you to specify the occupations of the orbitals per symmetry. In case of an unrestricted calculation you can also specify the occupations per spin type.

To show the available symmetries, ADFinput needs the result of an ADF calculation. If a previous calculation is available (without specifying the occupations), it will use the information from that calculation to generate the proper options in this panel. If such results are not available, ADFinput will suggest to run a short guess calculation: a preliminary run with an inaccurate grid, only a few SCF cycles and stopping immediately after the SCF. Hopefully this guess calculation will allow you to generate sensible occupation.

The energy levels of the guess calculation (or previous calculation if available) will be shown using ADFlevels. Be aware that it is the result of the guess calculation, and not your proper results!

**User Input**

You can use the User Input field to specify any kind of text. The text will be appended without any change to the end of the ADF input. This way, you may access some keys that are not (yet) available in ADFinput.

Note that at this point in time you can only add text to the ADF input file, not to the input of any of the property programs.

**Protein QMMM calculations with PDB files**

The handling of proteins has completely been changed with respect to ADFinput 2008. Now you just read a PDB file (either by opening it, or by importing it). All atoms will be read, including the PDB information like the residue and protein chain to which they belong. Now they are part of your molecule, and you can change or edit them as you would with any other molecule.

If many atoms are read (which is normally the case for a protein), the newly read atoms will be displayed using the wireframe option. This means that atoms without bonds (for example metal atoms) will be invisible! So you might want to make a new region with these individual atoms, and change the visualization option for that region to balls and sticks. Normally you can select such atoms by their residue name.

In the Regions panel for each chain detected in the PDB file, there will be a new line. This gives you a couple of visualization options (Ribbon, or all C, CA, N or O atoms connected). If you click on the triangle to the right you get a pop-up menu with some additional commands:

- New Region From Chain: make a new region, and put all atoms belonging to this chain into the new region
- Select Residue: select all atoms in a given residue (which you select from the menu)
- Residue Protonation: change the protonation state of some residues
- Add Hydrogen: add hydrogen atoms to this chain
- Add Selection To Chain: the selected atoms are marked as belonging to this chain
- Add Selection To Residue: the selected atoms are added to the specified residue

Many of these features depend on the proper PDB names for the atoms of the residues. If they are not correct, or non-standard, ADFinput may for example add hydrogens to the wrong positions, or visualize things incorrectly.
For the protonation state of some residues it is essential that their proper names are used: LYN/LYS, ASP/ASH, GLU/GLH, HID/HIE/HIP.

You can use the **Atoms → Details (Color, Radius, Mass, ...)** command to check and change the PDB names of the atoms.

The hydrogens that are added by ADFinput do not use a very advanced algorithm. For the protein itself it will be correct, in most cases. However, if you have solvent molecules in your PDB file the hydrogens will be added properly but the solvent molecules will be oriented incorrectly. For example, all waters will point in the same direction.

To properly add the hydrogens we advise you use some other tool, and save a PDB file with all atoms (including hydrogens).

Once you have set up your protein using these options, you can perform a QMMM calculation in the usual way. If you select the Amber95 force field, most of the atom types will be correct, based on their PDB name. Again, it is essential that the PDB name of the atoms is correct!

**Solvation: COSMO, SCRF(MEAD), Solvent Molecules**

To include solvation effects using ADFinput you have the following options:

- COSMO: use the COSMO model
- SCRF: use the SCRF (MEAD) method
- Explicit solvent molecules

To use COSMO or SCRF, select it from the Solvation method pull-down menu in the Solvation panel. The SCRF (MEAD) method requires a version of ADF that includes SCRF (MEAD). ADFinput will inform you if you do not have that yet. In that case, contact SCM to get a version with SCRF included.

To use explicit solvent molecules, use the 'Explicit Solvent Molecules' button to generate a solvation shell consisting of real molecules. The solvent molecules will be added to a newly created Solvent region.

**Output options**

In the Output panel you can set several output options.

An important change with respect to the previous version of the ADF-GUI is that the output will by default NOT include the output from the create runs. If you wish to have a look at those outputs as well, check the 'Results From Create Runs' check box. If you do not do this, it is very easy to generate these outputs as create runs take very little time.

Also, the logfile used to be appended to the logfile. This was not really useful in the ADF-GUI as the logfile will always be saved as a separate file to follow the progress of your calculation. If you wish that it is also appended to the output of ADF, check the Logfile option.

**Multi Level Calculations**

ADFinput supports several multilevel techniques:

- Fragment Analysis: your full molecule is composed of fragments. ADF calculates details of the interactions between these fragments for analysis purposes.
- FDE (frozen density embedding): within ADF this is a fragment calculation, but with some of the fragments consisting of a frozen density.
• QM/MM: one region of your molecule is described using full QM (the regular ADF method), the rest is described using a force field (MM)

• Quild: your system is composed of several systems, typically each including a bigger part of your molecule. For each part a different technique can be used. This is very much like the Oniomi model. You can find details about Quild in the Quild Users Guide.

All of these techniques require that different regions be defined. The regions panel in ADFinput allows you to do this in an easy and flexible manner.

Some of these techniques (QMMM and Quild) require you to set up different kinds of calculations. For example, and ADF input and and MM input. Or two ADF inputs but with different details like basis sets and integration accuracy. In these cases, for each calculation a tab will appear on the BOTTOM of the panels. Select which calculation you want to set up, and use the panels to set the details as usual. Normally there is one master tab on the bottom where you set up how the different calculations work together (QMMM or Quild).

**Regions**

A Region in ADFinput is defined as a collection of atoms. Atoms may be present in one or more region.

When you select the Regions panel you will find that one region has already been defined: All. This region consists of all atoms of your molecule, and is always present.

To add a new region, click the + button. If any atoms are selected when you press this button, they will automatically be added to this new region. With this new region you can do a couple of things:

- Click the - button: delete the region. Note that only the region is deleted, not the atoms in it.
- Click the check box to show the region graphically
- Click in the region name to change the name
- The check mark button: this selects all atoms currently in the region. In your molecule display you can easily see what atoms are in it, and it will also tell you how many atoms are contained in this region.
- The + button (on the right hand side): add the currently selected atoms to this region
- The - button (on the right hand side): remove the currently selected atoms from this region
- Click the triangle to get access to a pop-up menu with a number of commands that apply to that region.

The pop-up menu per region has the following options:

- Split By Molecule: split the region in many regions, based on the connectivity. Thus parts that are not bonded together will all be put in a separate region. The typical use is for solvents: first add a solvent with explicit molecules. The solvent molecules will automatically be put in their own region. Next, use the Split By Molecule command to split this into many small regions. If all your solvent molecules are identical, this leads to a very big time saving with fragment or FDE calculations. As the typical use is for replicated fragments, the naming of the newly generated regions will use the \n name, with n a number. Currently ADFinput does not check if the fragments are really identical!
- Replace Atoms By Solvent: the atoms in the region will be replaced by new solvent molecules. This is an easy way to adjust your solvent region.
- Invert Selection Within Region: perform an invert selection command, but just within the atoms part of this region.
- Region Color: set the color used to visualize the region
- Balls And Sticks: show the atoms and bonds in this region using Balls and Sticks
- Sticks: show the atoms and bonds in this region using Sticks only (that is, atoms not visible)
- Wireframe: show the atoms and bonds in this region using a wireframe only (again, no atoms visible)
- Hidden: do not show the atoms and bonds in this region
Regions can also be used in the Basis panel: you can change the basis per atom type per region. For example, give all carbon atoms in an outer region a smaller basis.

**Fragments**

In the Fragments panel you can:

- turn on the option to actually use the fragments within ADF
- specify an explicit fragment file (a .t21 result file)
- set a charge per fragment
- use the check charges checkbox
- open a fragment in ADFinput, so that you can set any detail of the calculation of this fragment

The fragments available are defined in the Regions panel. All atom need to be assigned to a region, and the regions may not overlap. The All region is ignored. Regions with names like 'Region/1', 'Region/2' etc are replicated regions: a fragment called Region will be generated, and will be reused for all these regions. It is the responsibility of the user to ensure that all these regions contain identical fragments.

The 'check charges' checkbox determines if ADFinput will make sure that the charges of the fragments added together do match the total charge of your molecule.

If you specify an explicit fragment file for a fragment, no job will be created to generate that fragment. Instead, ADF will use the fragment file that you select. It is up to you to make sure that this fragment file indeed describes exactly the fragment as you have defined in the Regions panel.

The default set up of the fragments is identical to all options you have chosen for your molecule, except for those features that will not work or do not make sense for fragment calculations. For example, ADF can use only 'restricted' fragments. Thus, even if you have an unrestricted calculation, the calculation on the individual fragments will always be done with restricted spin. If you click on the 'Open' buttons in the Fragments panel you can check exactly what options will be used for the fragments (and make changes to this if you desire)

Once you have set up your fragments, and choose the 'Save' command from the 'File' menu, ADFinput will generate a run script that will perform the fragment analysis. This script will first perform a calculation on each fragment (unless you have specified an explicit fragment file), and next perform the fragment analysis.

While your fragment job is running, you will always see the master fragment analysis job running in ADFjobs, and at the same time the individual fragment jobs (if any). This is because the fragment jobs are actually started from the master fragment analysis job. So the master job will wait for the fragment jobs before starting the fragment analysis run of ADF.

You can read more about the fragment analysis method available in ADF in the ADF Users Guide.

**Frozen Density Embedding (FDE)**

The FDE panel is used to set up an FDE calculation. This is a special kind of fragment calculation, and the Fragments panel is used to define the fragments as in any fragment calculation. The FDE panel allows you to select the frozen fragments, and to set some options on how these should be handled.

For further details on FDE, see the ADF Users Guide.
QM/MM

To perform a QMMM calculation, select the QMMM panel. Next, select what region you wish to be your QM region. All other atoms will be in the MM region.

On the right hand bottom you will find some new tabs, like QMMM, ADF and MM. With these you can select what options to set: the ADF tab allows you to set the details for the QM region, the MM tab allows you to set the details for the MM calculation. You should check the atom types used. Finally, the QMMM tab allows you to set general details on the QMMM calculation, like the capping method and so on.

In the MM tab you can set MM details. One of the options is the force field to use. Currently Tripos5.2 or Amber95 are available. You will need to make sure that the atom types are generated properly by ADFinput.

For the Amber force field, ADFinput only knows how to generate the proper atom types if your atoms have the proper PDB names. This is normally the case if you have imported the protein from a PDB file. Otherwise you can change PDB names of atoms using the Atom Inspector.

For the Tripos force field, ADFinput tries to guess the proper atom types. Some atom types will not be detected (this is marked in the input file), and you will need to adjust this manually.

If you prefer not to use QMMM, you can turn it off by selecting 'No Region' as QM region in the QMMM panel.

Quild

To perform a Quild calculation, you need to add actions. Each action determines how the system is evaluated. So, for example, first add an action to use MM for the full system. Next add an action to replace the MM method by a more accurate ADF calculation for a given region.

To add an action, click the + button. To remove an action press the - button in front of the action.

For each action specify its details: what region, which method to use. If the action is Total, that is all. If the action is Replace, you specify what method should be used for some region. If you leave the Remove method field empty, ADFinput will automatically use the method of the previous action.

You can change the action type (Total, Replace or Interaction) by clicking on it.

In most cases, the first action will be a Total action for the full system (the All region), and the next action will be a Replace action for a region describing some sub-system.

For a detailed description of the Interaction action see the Quild Users Guide.

Obviously you need to set up details for the different calculation methods. This is done using the tabs on the right hand bottom that appear once you start adding actions.

To revert to the normal situation (just one calculation setup), make sure you do not define any actions.

ADFview

Introduction

ADFview is a small utility program, which provides some basic visualization tools in 3D space. It will enable ADF and BAND users to visualize their results: SCF densities, orbitals, electrostatic potentials, and any other property that is available as a scalar value over a grid.
The property fields may be available on a 'TAPE41' file, with .t41 extension, or on a file formatted as a Gaussian cube file (with .cub or .cube extension). Alternatively, they can be computed from a 'TAPE21' file, with .t21 extension, as required by ADFview. For BAND calculations the property fields can be computed from a 'RUNKF' file, with .runkf extension.

Many preferences (background color, molecule resolution, etc) are shared with other ADF-GUI and BAND-GUI modules. Use the GUIprefs module to adjust the preferences (using the Preferences command from the SCM menu).

**Starting ADFview**

If you have installed the ADF package correctly, the adfview command is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFview program with the following command:

```
adfview [filename]
```

The filename is optional. ADFview only handles files with extension .t21, .t41, .runkf, .cub(e)

If a file name is given, ADFview will read the file and produce an image of your molecule just as ADFinput (or BANDinput) does. However, since neither old .t21 (before ADF2006), .t41, .runkf nor .cub(e) contains bond information, ADFview will in those cases just make a guess at the bonds to show. If you use a .t21 file that has been created using the ADF-GUI 2006 and matching ADF, the bond information will be read from a .t21 file. These bonds are the bonds as defined by the user using ADFinput.

A .t21 file is a result file produced by ADF that contains most results of the ADF calculation. The data is not yet in field format. ADFview knows what kind of fields can be generated from the data present in a .t21, and will offer those fields. When you select such a field, ADFview will calculate the field data (the function values on a 3D grid) on the fly (using the DENSF program).

A .t41 file is a file produced by DENSF that contains field information: values of some function on a 3D grid. A single .t41 file may contain many fields, and ADFview will make all fields available that are present in the .t41 file.

A .runkf file is a result file produced by BAND that contains most results of the BAND calculation. The data is not yet in field format. ADFview knows what kind of fields can be generated from the data present in a .runkf, and will offer those fields. When you select such a field, ADFview will calculate the field data (the function values on a 3D grid) on the fly (using the BAND program again).

A .cub or .cube file is a file produced by several programs, using the Gaussian cube format. ADFview can read such files to make it easier for you to compare results from ADF or BAND with results from other packages.

An alternative method to start ADFview: select the View command from the SCM menu. It will start using the .t21 file belonging to the calculation you were handling. In case of a BAND calculation it will start using the .runkf file belonging to the calculation you were handling.
Menu commands

File

New

Start over again, similar to quitting and starting ADFview without specifying a file name.

Open...

Open a .t21, a .t41, .runkf, or .cub(e) file to use for visualization.

You can have only multiple files open at the same time. If you open another file, it's fields are made available, so you can easily compare fields from different files.

Save Picture...

Save a picture of visualization area in a file.

The format used to save your picture is determined by the extension of the file name you specify. If you do not specify a known extension, it will use the standard picture format as specified using the 'Default Picture Format' menu.

Default Picture Format

Use the submenu to select the format to use when saving a picture.

Note that this is just the default to use, the user specifies the format with the extension. When the extension is not recognized (or when no extension is specified) the default format will be used.

Picture Resolution

Use the submenu to select the resolution that you want to use when saving a picture.

Export As VRML...

Export the current scene (molecule, surfaces, etc) as a VRML file. This file can be used by other utilities to visualize 3D scenes. Note that the objects are written to the file, not the rendered image. Thus, using a VRML viewer one can still rotate, zoom and so on.

Note that this is an experimental feature that might be improved or removed in future versions. Feedback is welcome!
Export Fields As Cube Files

Export all fields that have been calculated in the current ADFview session as Gaussian Cube files (.cub). A dialog will popup up telling you where the result files have been saved.

Quit

Quit ADFview. Nothing will be saved.

Add

When you add a visualization item, below the picture a new horizontal bar will appear with controls. These controls determine the details of the item you have added: what field to use for visualization, isovalues, colors, surface properties, etc.

Isosurface

Add an isosurface: a surface through a field connecting all points with same value (the isovalue).

For example, an isosurface showing the SCF density of your molecule.

The control bar has the following controls from left to right:

- Show/Hide checkbox (default checked: the isosurface is visible).
- Wireframe checkbox: if checked, show wireframe instead of solid surface.
- Isosurface pull-down menu: Copy To All Geometries command will create a similar surface for all open files (different geometries), Delete command to delete the surface, Show details will add an additional control-bar with more controls, and Hide details will remove the additional bar.
- Field pull-down menu: use it to select what field to make an isosurface from. If multiple files or geometries are present, the first entry might be used to select one. In the field menu you may notice that all listed fields have checkboxes in front of them. These will be checked if the field is available. If not checked, the field will be calculated in the background when you select it. Once a field is calculated, it will remain available as long as you do not open another file or quit ADFview.

The isovalue defining the isosurface.

The details bar contains the following controls:

- Opacity: determine the opacity of the surface. If less then 100% you can look through the surface. Note that often you will get visual artifacts if the value is not 100.
- Ambient: amount of ambient (non-directional) light (0-100).
- Diffuse: amount of diffuse (directional) light (0-100).
- Specular: strength of highlights (0-100).
- Power: extent of highlights (specular power).
**Isosurface: Colored**

Add an isosurface: a surface through a field connecting all points with same value (the isovalue). The isosurface will be colored by a second field.

For example, an isosurface showing the SCF density of your molecule, colored by the electrostatic potential.

The control bar has the following controls from left to right:

- Show/Hide checkbox (default checked: the isosurface is visible).
- Wireframe checkbox: if checked, show wireframe instead of solid surface.
- 'Isosurface: Colored' pull-down menu: Copy To All Geometries command will create a similar surface for all open files (different geometries), Delete command to delete the surface, Show details will add two additional control bars with more controls, and Hide details will remove the additional bars.
- Field pull-down menu: use it to select what field to make an isosurface from.
- The isovalue defining the isosurface.
- Field pull-down menu: use it to select what field to color the surface with.
- Two numbers: the range of the color field used for mapping colors.
- Log checkbox: use a logarithmic color scale.
- Bar checkbox: show a color bar as legend for the color field.

The first details bar contains the same controls as for a normal Isosurface.

The second details bar contains the controls defining the mapping of the color field to a color. The color is specified using the HSV color space.

The hue is what is normally thought of as color. Saturation is the amount of gray, white, or black that is mixed into the color. Zero saturation indicates no hue, just gray scale. The value component of the HSV space is a measure of its brightness. The HSV color space is normalized.

- Color Scale pull-down menu: four different presets of coloring settings (color scale, gray scale, white or black). The last entry 'Store As Default' will store your current color settings as default.
- Hue (two numbers): the lower end of the color field maps to the first hue value, the upper end maps to the second hue value, and the other values are generated linearly (or logarithmically) in between.
- Saturation (two numbers): the lower end of the color field maps to the first saturation value, the upper end maps to the second saturation value, and the other values are generated linearly (or logarithmically) in between.
- Value (two numbers): the lower end of the color field maps to the first intensity value, the upper end maps to the second intensity value, and the other values are generated linearly (or logarithmically) in between.

**Isosurface: Double (+/-)**

Add a double isosurface: just two isosurfaces at the same time, of different colors, through the same field. One isosurface corresponds with the chosen isovalue, the other one with the negative of that value.
The main control bar is identical to the control bar of a normal isosurface. If you show the details, you will find that in addition to the controls available for a normal isosurface, you can also specify coloring information. In this case, the two numbers for the HSV colors define the colors of the negative and positive isosurface.

**Cut Plane: Colored**

Add a plane, and color the plane with some field.

The control bar has the following controls from left to right:

- Show/Hide checkbox (default checked: the cut plane is visible).
- Wireframe checkbox: if checked, show wireframe instead of solid surface. Not very useful.
- 'Cut Plane: Colored' pull-down menu: Copy To All Geometries command will create a similar surface for all open files (different geometries), Delete command to delete the surface, Show details will add two additional control bars with more controls, and Hide details will remove the additional bars.
- Field pull-down menu: use it to select what field to color the plane with.
- Position plane checkbox: if checked, in the picture handles will appear. Using these handles you can orient and move the cut plane. Uncheck to remove the handles.
- With atoms: press this button to orient the plane with 1, 2 or 3 atoms selected. With 1 atom selected move the plane to go through that atom. With 2 atoms selected, the axis between these atoms defines the plane normal, and it will be positioned exactly between the two atoms. With 3 atoms selected, move the plane such that all three atoms are in the plane.
- Two numbers: the range of the color field used for mapping colors.
- Log checkbox: use a logarithmic color scale.
- Bar checkbox: show a color bar as legend for the color field.

The details control bar contains the coloring controls, as for a colored isosurface.

**Cut Plane: Contours**

Add a plane, and on that plane show contour lines for the requested contour values of some field. The contours will be colored by the value of the field.

The control bar is the same as for a colored cut plane, with the addition of the number of contours.

The details bar contain coloring information, as before. And an additional details bar is present to change the appearance of the contours: you can make the contour lines thicker (with line width), or choose to use dots of a specified size instead of lines. Note that activating the dots option makes rendering much slower.

**Cut Plane: Contours (+/-)**

Add a plane, and on that plane show contour lines for the requested contour values of some field. In this case, the positive and negative contours are shown in a different way, determined by the controls.
All controls are identical to the controls of a contour cut plane. The behavior is different: you specify the number and range of positive contours, possibly using a logarithmic scale. ADFview will automatically generate negative contours as well with similar values. All positive contours are drawn using one color, and all negative contours are drawn with a different color.

The coloring controls determine the colors of the negative and positive contours.

Using the Dashed checkbox, dashed lines will be used for the negative contours. This means that you can use one color (black for example) for all contours and still distinguish between the negative and positive contours.

**COSMO surface: Colored**

Show the COSMO surface as used in a Cosmo calculation. Only accessible for .t21 files that contain COSMO results.

**Spinor: spin magnetization density**

Only accessible in case of a spin-orbit coupled calculation with a TAPE21 (.t21) file to visualize a spinor.

Visualization of spinors is more difficult than visualization of orbitals. A spinor $\Psi$ is a two-component complex wave function, which can be described with four real functions $\phi$: real part $\alpha \phi_\alpha^R$, imaginary part $\alpha \phi_\alpha^I$, real part $\beta \phi_\beta^R$, imaginary part $\beta \phi_\beta^I$:

$$\Psi = \begin{pmatrix} \phi_\alpha^R + i \phi_\alpha^I \\ \phi_\beta^R + i \phi_\beta^I \end{pmatrix}$$

The density $\rho$ is:

$$\rho = \Psi^\dagger \Psi$$

The spin magnetization density $m$ is:

$$m = \Psi^\dagger \sigma \Psi$$

where $\sigma$ is the vector of the Pauli spin matrices $\sigma_x$, $\sigma_y$, and $\sigma_z$. A spinor is fully determined by the spin magnetization density and a phase factor $e^{i\theta}$, which both are functions of spatial coordinates.

The (square root of the) density and spin magnetization density are visualized as a double isosurface and a vector field respectively. The phase factor $e^{i\theta}$, reduced to a plus or minus sign, is visualized with the double isosurface and with the color of the vector field.

The main control bar is identical to the control bar of a normal isosurface. If you show the details, you will find that in addition to the controls available for a normal isosurface, you can also specify coloring information. In this case, the two numbers for the HSV colors define the colors of the minus and plus sign.

**Add Bond**

First select two atoms. Next use this command to add a bond. This is for visual purposes only.
**Guess Bonds**

Use the same algorithm as ADFinput uses to guess the bonds.

**Remove Bonds**

Delete the selected bond. Mainly to correct ADFview if it mistakenly is showing some bond that really should not be present.

**HOMO-1**

Generate a double isosurface showing the HOMO-1 orbital. If it is degenerate, only one of the degenerate orbitals will be shown.

**HOMO**

Generate a double isosurface showing the HOMO orbital. If it is degenerate, only one of the degenerate orbitals will be shown.

**LUMO**

Generate a double isosurface showing the LUMO orbital. If it is degenerate, only one of the degenerate orbitals will be shown.

**LUMO+1**

Generate a double isosurface showing the LUMO+1 orbital. If it is degenerate, only one of the degenerate orbitals will be shown.

**Bader Sampling**

Show the grid points that are used for the Bader analysis. This gives you a rough idea of the Bader basins.

**Fields**

**Calculated**

Create a new control bar where you can define a new field as some mathematical function of one or two existing fields. Once the field is defined in this way, you may use it in any place where a field is used.

The mathematical operations are split in three groups: operations between two fields (+, -, /, *, min, max), operations on one field (abs, square, sqrt, sin, cos, invert, log, exp) and operations between a constant and a field (+, *). Once you have calculated a field, you may also use it in another calculated field.
**Interpolated**

Create a new control bar where you can define a new field as an interpolated field of an existing field. Using the interpolation you can either increase or reduce the number of grid points (for respectively a smoother picture, or for faster rendering).

The controls are simple: select the field to interpolate, select either linear or cubic interpolation, and select a interpolation factor. A factor of 2.0 means that in every direction you will get twice as many points, thus your grid will be 8 times as big. Similarly, specifying a factor of 0.5 will reduce the size of your grid by a factor of 8.

**Grid**

Define the grid resolution that should be used when calculating fields in the background.

A fine grid produces the most accurate results, but might be slow for big molecules. A coarse grid does not look as good, but will be much faster for big molecules.

When you change the Grid choice, the fields that have already been calculated may be recalculated. If you have more than one field already present, ADFview will ask you to confirm that you indeed wish to recalculate the fields already present. Whatever you choose, the Grid setting will always apply for newly calculated fields.

**Sort by**

In the field menus in the control bars you will have a list of all MOs. They are sorted in the way you select here (either by energy or by symmetry).

**View**

**Standard View commands**

See Standard View commands.

**Show Scene Light**

Add a control bar below the picture with some scene light controls. You may activate a scene light: this light will be in a fixed position with respect to your molecule. Using the controls, you may reposition the light, and you can set the relative intensity of the scene light and normal light source.

**Show All Geometries**

Show all visualization items, belonging to all geometries, if checked. Otherwise, only show those items that are related to the current geometry.
Auto Update

When the auto update mode is enabled (the default situation), the display is continuously updated when you make changes. Sometimes this update may be slow, for example when updating means that new isosurfaces need to be computed for a large grid. As you probably will make more changes (fix colors, set isovalues, change field to use, etc) the auto-update feature may become a pain.

If you uncheck the Auto Update option, no more updates will be performed.

To refresh the screen, either press Return, or use the Update command from the field menu.

Update

Force a refresh of the screen. This will only be required when the auto update mode has been disabled.

Help

The help menu provides an easy way to get to information about the ADF-GUI. It will start a browser on your local machine, and connect to the SCM web site to get information.

Comparing data from several molecules

ADFview can handle more than one molecule at the same time. You can show fields for different molecules in the same window, you can create calculated fields to see differences, and so on.

The different molecules may come from different files, or from one result file containing multiple geometries. An example of the first situation would be two different calculations, with different XC potential, resulting in two different .t21 files. An example of the second would be the .t21 file from a NEB calculation. That file contains the information for all images, so you can see how (for example) the HOMO changes from image to image.

To add a new molecule from a different file, just open an additional file using the Open menu command from the File menu.

The current geometry

ADFview has a 'current' geometry. The molecule shown will be the one for the current geometry only.

To change the 'current' geometry, use the horizontal slider below the molecule window.

The visualization items (surfaces) might be filtered in such a way that only items related to the current geometry are shown. This is the default when visualizing NEB results: you want to see how the density or an orbital changes going from one image to the next (using the slider). If you open different files the default is to show visualization items for all geometries at once. Thus you might compare orbitals from one fragment with those from another. You can switch this behavior using the 'Show All Geometries' menu command from the View menu.
Comparing different calculations

You can easily compare calculations on the same molecule that differ in something else then geometry. Just open both result files (.t21). Next, you can calculate differences between similar things. If you add a calculated field, you will find that the first command in the field select menu is used to select the geometry from which to take the data. Thus, you can select the same property from different files and compute the difference.

Warning: The current implementation has no possibility to adjust the orientation or the grid. In practice this means that you need to take care that the fields that you compare actually make sense to compare. This is only the case if the geometry of the molecules is identical and thus the grid is identical. Though this is very restrictive, you can make interesting comparisons for a given molecule: change due to different XC, basis sets or integration accuracy for example.

Temporary Files

ADFview normally will run DENSF or BAND in the background. This means that it needs scratch space to store inputs and result files to be visualized. After normal termination of ADFview (using Quit) all scratch files will be removed.

The scratch files will be created in the following location:

- If $SCM_TMPDIR is defined: use the $SCM_TMPDIR directory
- else, if $HOME is defined: use the $HOME directory
- else, if $TMPDIR is defined: use the $TMPDIR directory
- else try to use the current working directory.

ADFdos

Introduction

ADFdos shows the DOS (density of states) calculated by ADF (or BAND).

You can select the atoms and functions for which you want to see the DOS. For ADF this is calculated using the DOS program, the TDOS and GPDOS options. For BAND this generated from data that BAND has pre-calculated.

Starting ADFdos

If you have installed the ADF package correctly, the ADFdos program is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFspectra program with the following command:

adfdos [filename]

The filename is optional. ADFdos handles the ADF binary TAPE21 files (.t21), and BAND RUNKF (.runkf) result files.
There is a second possibility to start ADFdos if one of the GUI modules has already been started. All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. Using this SCM menu, ADFdos can be started by selecting the 'Dos' command.

**Using ADFdos**

After starting you can open a file with the **File → Open** menu command.

Now you will get a window with the molecule on the left side, and the DOS graph on the right side.

The currently displayed DOS type (Total Dos, or some partial GPDOS) is always shown on the top right side of the DOS graphs.

If no atoms are selected, the total DOS is always displayed.

Select atoms to show the GPDOS corresponding to the selected atoms.

Using a right-mouse click on an atom you will get a pop-up menu. It contains the usual commands to adjust the display of the atoms, but you can also use it to select the GPDOS for S, P, D or F functions of the selected atoms. Note that the S, P, D and F selection will be shown only for selected atoms. If no atoms are selected, the full DOS is always shown. Thus no atoms selected is not the same as all atoms selected, when you have selected the S orbitals for some atoms!

If you are visualizing a BAND result file, you can also restrict the GPDOS to selected atomic orbitals.

In the graph window you can zoom in and translate with the mouse. And if you click below the axes you will get a dialog box allowing you to set graph details. This behavior is exactly the same as in ADFmovie or ADFspectra.

If you zoom in a lot, ADF DOS results will be recalculated interactively. BAND DOS results have been pre-calculated, so at some point you will loose to much detail.

You can show multiple DOS plots at the same time, for example the total DOS and the GPDOS for some selected atoms. To do this, use the 'View: Add Graph' menu command. By clicking in a graph you make it active. Next, all changes you make with your molecule will apply to the selected graph only.

When zooming or translating the graphs behave as independent graphs. You can make them zoom synchronized using the 'View: Synchronize Graph X Axes' command.

In the File menu you will find the 'Save As PostScript' and 'Save As XY' commands that you can use to save a graph as either a postscript file, or as a list of X and Y values (to be plotted with your favorite plotting tool).

**ADFspectra**

**Introduction**

ADFspectra shows the spectra calculated by ADF. Currently it can show IR, PVDOS, Raman, excitation, CD, MCD and VCD spectra, as well as a DOS plot. For some spectra (for example for IR spectra) it can also provide additional information, like a visualization of the normal modes (using ADFmovie) or showing orbitals involved.

A PVDOS spectrum has additional options to select one or more atoms contributing to the spectrum.
Starting ADFspectra

If you have installed the ADF package correctly, the ADFspectra program is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFspectra program with the following command:

```
adfspectra [filename]
```

The filename is optional. ADFspectra handles the ADF binary TAPE21 files (.t21).

There is a second possibility to start ADFspectra if one of the GUI modules has already been started. All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. Using this SCM menu, ADFspectra can be started by selecting the 'Spectra' command.

Zooming in or out

To zoom in any of the spectra use the mouse wheel, drag with the right mouse button in horizontal direction, or drag with the left mouse button while pressing the control key (again in horizontal direction). The spectrum will automatically update.

To move the spectrum without zooming, drag with the left mouse button.

Peak width and shape

Use the pull down menu at the bottom of the window to choose either a Gaussian or a Lorentzian peak shape.

In the input field next to it you can set the required peak width (in units matching the currently active units for the horizontal axes). This is the width of the peak at half-height.

When you select a fixed area shape, the peak is normalized such that the surface below the peak is 1.0. The fixed height version will normalize the peaks such that the height of the peak is 1.0.

Scaling peak positions

You can scale all peak positions with a constant factor by adjusting the Scaling factor in the lower left corner of the window.

Axes menu

Horizontal Unit

Select the unit that you want to use for the horizontal axes (the energy / frequency axes).

Flip Horizontal or Vertical

Change the horizontal direction (from low to high frequencies or the reverse). You can also flip the vertical axes.
Save Postscript

Save the current spectrum as a postscript file.

Export XY values

Export the current XY values (in the resolution matching the current picture) to a text file so that you can use it in your preferred graphing application.

DOS (density of states)

Select the 'DOS' command from the 'Spectra' menu. Part of the results of the calculation is typically a large number of orbital energies. These may be graphically represented as a DOS (density of states).

The little red line below the horizontal energy axis corresponds to the Fermi level (the highest occupied orbital). The height of the peaks depend on the number of peaks close together (real or accidental degeneracies).

When you move the mouse above a peak, a pop-up will provide detailed information. When clicking on a line in this pop-up window, the corresponding orbital will be shown using ADFview.

The orbital energies, with their symmetry and occupation numbers, are also available from the menu.

Vibration (IR spectrum)

Select the 'Vibration' command from the 'Spectra' menu. This is only possible if ADF has calculated the IR frequencies.

The red lines on the baseline indicate the peak positions as calculated by ADF. The peak positions, with their symmetry and intensity information, is also available from the menu.

If you move your mouse above a peak, a pop-up window will show more information about that peak. If you click on a normal mode shown in this pop-up window, ADFmovie will show this particular normal mode. You can also click and hold the mouse button (or right-click) on the peak itself. A pop-up menu will appear, and you may select the normal mode to visualize from that menu. If you just click on a peak all normal modes contributing to that peak will be shown.

You can scale the displacements used when visualizing a normal mode in ADFmovie using the 'Scale Displacements' menu command from the Edit menu. You can also choose to visualize the normal modes by drawing vectors instead of using an animation. In that case, the 'Scale Displacements' will scale the vectors drawn.

PVDOS spectrum

Select the 'PVDOS' command from the 'Spectra' menu. This is only possible if ADF has calculated the IR frequencies, and written the PVDOS info (ADF2009 and later).

The usual spectrum window will appear, but in addition your molecule will be visible on the left side. Use the mouse to select one or more atoms in your molecule. The spectrum will show the PVDOS for the selected atoms.
Optical spectrum

Select the 'Excitation' command from the 'Spectra' menu. This is only possible if ADF has calculated the excitation energies.

When you position your mouse above a peak, a pop-up window will appear showing detailed information about that peak. When you click on a line with a particular contribution in that pop-up window, ADFview will show the orbitals involved in that transition.

CD spectrum

Select the 'CD' command from the 'Spectra' menu. This is only possible if ADF has calculated the circular dichroism spectrum.

MCD spectrum

Select the 'MCD' command from the 'Spectra' menu. This is only possible if ADF has calculated the MCD spectrum.

The MCD spectrum will NOT show the A-terms, if any. However, if you move your mouse over the peaks the value of the A-terms will be displayed. The B- and C- terms are included.

The spectrum displayed corresponds to the selected temperature and magnetic field. You can change these using the menu. The only possible choices for the temperature and magnetic field are the values for which the MCD has been calculated. You set this up in the ADF input (for example using ADFinput).

Raman

Select the 'Raman' command from the 'Spectra' menu. This is only possible if ADF has calculated the Raman spectrum.

VCD

Select the 'VCD' command from the 'Spectra' menu. This is only possible if ADF has calculated the VCD spectrum.

NMR

Select the 'NMR' command from the 'Spectra' menu. This is only possible if ADF has calculated the NMR shifts.

On the left side, your molecule will be shown. On the right sight, you will get a graph showing the NMR shieldings.

The Standard View menu will be available in the menu. It allows you to show atom names and so on. You will also have a Nucleus menu. That menu is used to select which NMR shieldings to display: you have to select this per element.
When you mouse over one of the peaks, you will get a balloon with detailed information. Clicking on a peak will select the corresponding atoms on the left side. Selecting one or more atoms will mark the corresponding peaks in the spectrum.

Currently the effect of spin-spin coupling is not included in the spectrum, even when you have calculated these.

**ADFmovie**

**Introduction**

ADFmovie is a small utility program, which follows geometry steps as performed by ADF during geometry optimizations, IRC calculations, etc. Actually, it will display just any series of changing geometries, and is also used to display normal modes calculated with a frequency calculation. ADFmovie can also show graphs related to the geometry steps, for example the energy as function of the optimization step, or as function of some user-selected distance.

When you use ReaxFF, ADFmovie will not only show the movie (trajectory) of your simulation, but it can also present graphs with the properties that ReaxFF has calculated.

**Starting ADFmovie**

If you have installed the ADF package correctly, the ADFmovie is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFmovie program with the following command:

```
adfmovie [filename] [-loop] [-nobondupdates]
```

The filename is optional. ADFmovie handles ADFmovie files (.amv) and ADF logfiles (.logfile), both types are text files, and the ADF binary TAPE21 files (.t21).

If the -loop command line option is chosen, ADFmovie will display the series of the geometries in the specified file over and over again. This is used, for example, by ADFspectra to visualize normal modes. The -nobondupdates option prevents ADFmovie to guess the bonds each frame. This makes the performance much better, and is normally used when displaying normal modes.

There is a second possibility to start ADFmovie if one of the GUI modules has already been started. All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. Using this SCM menu, ADFmovie can be started by selecting the ’Movie’ command.

**Buttons**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• rewind the movie,</td>
</tr>
<tr>
<td>• play the movie backwards,</td>
</tr>
<tr>
<td>• pause or resume playing the movie,</td>
</tr>
<tr>
<td>• play the movie,</td>
</tr>
<tr>
<td>• skip to the end of the movie.</td>
</tr>
</tbody>
</table>
Input Files

TAPE21 and logfile

If a TAPE21 file (ADF binary) or an ADF logfile (text file) is selected, ADFmovie displays the series of the changing geometries in the specified file. Typically this will be the change in geometry of a molecule as a result of a geometry optimization, an IRC run, or a frequency run.

If you make a movie of a running calculation, the logfile will be used by default. ADFmovie does have live-updating: the movie will automatically grow when more frames will be available in the logfile.

If it is generated with ADFinput, the ADF logfile file will have a .logfile extension, and the ADF data result file TAPE21 will have the .t21 extension.

ADFmovie files

At the moment the ADFmovie files (.amv) are generated only by ADFspectra, if the vibrational spectrum is shown and one of the normal modes is selected. If this is the case the -loop option of adfmovie is selected.

It is easy to make an ADFmovie file yourself, since it is just a text file with series of coordinates, for several frames of the movie.
An example with rather arbitrary coordinates:

```
water geometry 1
H 0.0 0.0 0.0
H 1.0 0.0 0.0
O 0.0 2.0 0.0

water geometry 2
H 0.0 0.0 1.0
H 0.0 1.0 0.0
O 3.0 0.0 0.0

water geometry 3
H 0.0 0.0 0.0
H 0.0 1.0 1.0
O 6.0 0.0 0.0
```

Note: a title (like water geometry 1) should be provided for each new geometry, and an empty line should separate the different geometries.

Geometry Information

Using the mouse you can select atoms. If you select some atoms the corresponding geometry information is shown at the bottom of the window: distance, angle or dihedral angle. When you play a movie this information will continuously be updated.
Geometry information is also possible in the molecule window itself using the View → Geometry Info menu command.

Menu Commands

File: Open...

Select a file to open, closing the currently visible file.

File: Save Geometry...

This command will save the coordinates of the currently visible frame in a file (using a simple xyz format).

File: Update Geometry in Input

Open ADFinput (or BANDinput) with the matching file, and update the coordinates with the coordinates of the currently visible frame.

File: Save Picture...

Save a picture of your molecule (only the drawing area with your molecule, no input options) in a file. The format used to save your picture is determined by the extension of the file name you specify. If you do not specify a known extension, it will use the standard picture format as specified using the 'Default Picture Format' menu.

File: Save Movie Frames...

Perform a Save Picture command for all frames in the move. A sequence number will be appended to the filename you specify. You can use an external program to link these pictures together to a real movie.

File: Save .mp4 Movie...

Saves the movie frames, and automatically makes a MPEG movie out of it using ffmpeg. This will only work if you have ffmpeg installed, and if the ffmpeg command is in your path.

File: Save Movie Coordinates...

For each frame of the movie, write the XYZ coordinates (with atom name) to a file. This is the .amv file format. You can read it with ADFmovie. As it is just a series of XYZ coordinates, it should be easy to adapt such that other programs can read it as well.

File: Default Picture Format

Use the submenu to select the format to use when saving a picture.
Note that this is just the default to use, the user specifies the format with the extension. When the extension is not recognized (or when no extension is specified) the default format will be used.

**File: Picture Resolution**

Use the submenu to select the resolution to use when saving a picture.

**File: Quit**

Stop ADFmovie.

**View: Standard Commands**

See View: Standard Commands.

**View: Loop**

When checked, playing the movie will use a loop (after the last frame it jumps to the first frame). This is normally only used to show normal modes (and in that case it is activated automatically).

**View: Converged Geometry Only**

If you are showing a movie from a linear transit or IRC calculation, show only the optimized geometries.

**View: Displacement Vectors**

Show vectors from the first frame to the frame about 25% of the movie. The vectors are visible only in the first frame. Typically you use this to show the displacement vectors for some normal mode.

**View: Scale Displacements**

The displacements will be made larger or smaller. This only makes sense when you are looking at a normal mode. The amplitude of the normal mode will be scaled, typically to make it easier to see if it consists of many small displacements. The displacement vectors will also be scaled if they are visible.

**Graph: Energy**

Show a graph of the energy.

**Graph: Optimizer Energy**

Show a graph of the energy used by the optimizer, if available.
Graph: Distance, Angle, Dihedral

Select 2, 3 or 4 atoms. Next this command will show a graph of the corresponding distance, angle or dihedral. Note that if you have a movie with many frames this will take a long time as all frames need to be parsed to create this information.

Add Graph

Add a new graph. Normally you do not need this, but you can use if if you wish to have several graphs with only one curve per graph.

Delete Graph

Delete the active graph.
The active graph is the last graph used, or the last graph clicked.

Delete Curve

Delete the active curve.
The active curve is either the last curve generated, or the last curve clicked.

Curve On X Axes

Move the active curve to the X-axes.
The active curve is either the last curve generated, or the last curve clicked.

Curve On Left Axes

Move the active curve to the left Y-axes.
The active curve is either the last curve generated, or the last curve clicked.

Curve On Right Axes

Move the active curve to the right Y-axes.
The active curve is either the last curve generated, or the last curve clicked.

Quild Energies

Use the sub-menu to make graphs of several quild energies (the energies of the sub-systems).
Save As PostScript

Save the current graph in postscript format.

The active graph is the last graph used, or the last graph clicked.

Save As XY

Save the current graph in XY format, to be handled by your favorite plotting program.

The active graph is the last graph used, or the last graph clicked.

ADFlevels

Introduction

ADFlevels shows you a diagram of the energy levels (orbital energies) of your molecule. It may also show the levels of the fragments used in a calculation, or you may show the energy levels of different molecules at the same time for comparison. ADFlevels can also show how a molecular level is composed of fragment levels (an interaction diagram).

Starting ADFlevels

If you have installed the ADF package correctly, ADFlevels is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFlevels program with the following command:

adflevels [filename]

The filename is optional. ADFlevels only handles TAPE21 files with extension .t21.

There is a second possibility to start ADFlevels if one of the GUI modules has already been started. All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. Using this SCM menu ADFlevels can be started by selecting the 'Levels' command.

ADFlevels window

Stacks: Molecule, Fragment types, Fragments

All levels that are shown are organized in 'stacks': all levels from a molecule or fragment are shown in one (vertical) stack. You may have several stacks visible: one or more molecule, fragment types or fragments.

A molecule stack shows the energy levels of a molecule. These levels correspond one-to-one to molecular orbitals, and using pop-up menus (click and hold) you may instruct ADFlevels to show a particular molecular orbital.
A fragment stack shows the energy levels for a particular fragment. If you have more than one of these fragments in your molecule you may see several of these stacks. The stacks will be identical, but with different interaction lines to the molecular levels.

A fragment type stack shows the energy levels for a particular fragment type. Your molecule may contain one or more fragments of this type. Often it is convenient to collapse individual fragment information into fragment type information: it greatly reduces the clutter.

You control which stacks are visible using menu commands or pop-up menus.

**Mouse interaction**

**Zooming and Translating**

You can zoom with the scroll wheel, by dragging with the right mouse button, or by dragging with control-left-mouse button. You can only zoom in the vertical axes (the energy axes). Drag with the left mouse button to reposition the diagram.

**Selecting**

To select a stack, click on its name at the bottom of the window.

To select a level, click on it. Shift clicking on a level will add that level to the current selection, or remove it if it was already selected.

To select a group of levels in one time: shift - drag with the mouse a rectangle around the levels that you want to select.

**Moving a stack**

If you click and start dragging in the name of a stack, you can reposition a stack and thus change the order in which they are shown.

**Menu commands**

**File: Open...**

Close the current project and select a new tape21 file to open.

**File: Add...**

Select a new tape21 to open. This will be added to the same diagram so you can compare two systems.

**File: Save Postscript...**

Save the current diagram as a postscript file.
File: Quit

Stop and quit ADFlevels.

Axes: Reset Zoom

Normally you do not view all levels, but you are zoomed in. Use the Reset Zoom command to reset the zoom view to the default value. Note that more control about zooming out is available from a pop-up menu available for a stack.

Axes: Unit

Use one of the submenu commands to change the unit of the vertical axes into the selected unit.

In the menu you can see which unit is active.

View: Interactions

Show or hide interactions for the selected levels. If nothing is selected, show all interactions.

View: Occupations

Show or hide the arrows indicating the occupations of the selected levels. If nothing is selected, it applies to all levels.

View: Labels

Show or hide the labels for the selected levels. If nothing is selected, it applies to all levels.

View: Fragments

Show all real fragments (not fragment types) for your molecule (thus typically many stacks). The fragment types will remain visible as long as you do not hide them.

View: Fragment Types

Show the selected fragment type.

View: Hide Stacks

Hide the selected stack (no matter what kind). You first need to select the stack, you do this by clicking on the name of the stack at the bottom of the window.

Help

Provide quick access to the documentation on the SCM website.
**Pop-up menus**

You activate pop-up menus by pressing the (left) mouse button on an object, and keep the mouse button pressed down for some time until the menu pops up.

**Background (white space) pop-up**

Reset zoom for entire diagram.

**Stack pop-up**

Most commands are evident. The shift stack command will allow you to offset all energy levels of a particular stack with a constant value.

**Level pop-up**

Most commands are alternatives for regular menu commands, except for the orbitals listed. If you select an orbital that orbital will be shown using ADFview. You can also show all orbitals (in the case of a degenerate level) at once.

**ADFtail**

**Introduction**

ADFtail is a (very) small utility program, which makes it possible for ADF and BAND users to follow the progress of an ADF or BAND calculation (similar to the UNIX tail -f command) by showing the end of the ADF or BAND logfile.

**Starting ADFtail**

If you have installed the ADF package correctly, ADFtail is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFtail program with the following command:

`adftail [filename]`

The filename is optional. ADFtail only handles text files, but is mainly useful for the logfile generated by ADF or BAND. If it is generated with ADFinput, the ADF or BAND logfile file will have a .logfile extension.

There is a second possibility to start ADFtail if one of the GUI modules has already been started. All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. Using this SCM menu ADFtail can be started by selecting the 'Logfile' command.
**ADFtail window**

The ADFtail window is the ADF or BAND logfile, which is generated during an ADF or BAND calculation and flushed after (almost) each message that is sent to it by the ADF program. Consequently the user can inspect it and see what is going on without being delayed by potentially large I/O buffers. Each message contains date and time of the message plus additional information on how far the calculation has progressed.

In the ADFtail main window the last part of the ADF or BAND logfile is shown. Using the scroll bar you can move around in a linear version. At this point using ADFtail is equivalent to using any WYSIWYG-editor. If the logfile file grows during a calculation, ADFtail will update itself and show the text file as it grows (similar to the UNIX tail -f command).

You can use the **Edit → Copy** command to copy text to the clipboard if you wish.

**ADFoutput**

**Introduction**

ADFoutput is a small utility program, which makes it easier for ADF and BAND users to browse through the output of an ADF or BAND calculation.

When loading a file, either at startup or by using the File/Open command, ADFoutput scans the entire file and locates many special points of interest in this file. All these points are linked to menu entries. These menu entries are organized to make it easier to find the entry you are looking for. Furthermore, still during this initialization phase, ADFoutput will try to detect the different parts in an output file. For example, many outputs will consist of the output from one or more ADF Create runs followed by one or more molecular runs. ADFoutput will find these parts and put them in its 'Include' menu.

**Starting ADFoutput**

If you have installed the ADF package correctly, the output browser ADFoutput is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFoutput program with the following command:

```
adfoutput [filename]
```

The filename is optional. ADFoutput only handles text files, but is mainly useful for the output file generated by ADF or BAND. If it is generated with ADFinput the ADF output file will have a .out extension. If it is generated with BANDinput the BAND output file will have a .out extension.

There is a second possibility to start ADFoutput if one of the GUI modules has already been started. All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small SCM logo. Using this SCM menu ADFoutput can be started by selecting the 'Output' command.

**ADFoutput window**

**Main Window**
In the ADFoutput main window the complete output file is shown. Using the scroll bar you can move around in a linear version. At this point using ADFoutput is equivalent to using any WYSIWYG-editor.

**Click on Marked Items**

The points of interest in the file have also been marked visually. Clicking on one of them will jump to the next point of interest of the same kind. Shift-Clicking will do the same but jumping to the previous point of interest.

**Include Menu**

The Include menu is often very informative since it provides at a glance the overall structure of the file you are looking at. If you select any of the parts ADFoutput will jump to that part in the file, and it will restrict all operations (except a new Restrict command) to this part. This makes it very easy to study a single part of the output file without getting lost in another part.

**Other Menus**

The other menus (Properties, Iterations, except File and Edit) contain the special markers (Points of Interest) which have been detected when opening the file. Choosing one of their menu items will jump to that item, or beep if that is not possible (because you included only part of the output to view using the Include menu). The search will wrap around.

Using the ADFoutput menus you can find easily what you are looking for. The property menu gives access to all calculated properties, including excitation energies, polarizabilities, NMR results and bonding energy analysis.

**GUIprefs**

**Preferences**

All preferences used by the ADF-GUI modules are managed by the GUIprefs module. Some preferences are specific for particular modules, other preferences will be used by many different modules.

The GUIprefs module should be started using the SCM → Preferences menu command.

After starting you will get a window with a pull-down menu at the top. Use it to select the different panels: Display, Colors, Atom Colors, Fields, ADFjobs or Environment.

The File → Reset Defaults command will reload the defaults as distributed by SCM, overwriting any changes you made. This will be done immediately and cannot be undone.

**Save and Preview**

On each panel you will find a Save and an Preview button at the bottom.

The Preview button will use the new preferences in all open ADF-GUI and BAND-GUI modules. However, the preferences are not saved. Use this button to see the effect of your changes. For example, you can try and see if you like the new colors that you define. When you quit the GUIprefs module, your changes will be undone (unless you saved them).
The Save button will save your changes, and also use them for all open modules. Obviously any module that you start next will also use the new preferences.

If you Quit the GUIprefs module it will NOT save the preferences. You need to click the Save button explicitly. This avoids accidentally overwriting of your preferences.

The preferences are save in the file $HOME/.scm_guiRC, unless you specify some other file using the SCM_GUIRC environment variable.

Display

Use this panel to set up the display of your molecule or solid in the 3D windows. The options should explain themselves. If not, move the mouse to an option and do not move it, and a help balloon will appear with more information about that particular option.

One useful new addition in this panel is the global Font Size setting. This will change the font sizes in all ADF-GUI and BAND-GUI modules. Note that this will lead to an ugly layout in some cases, it is mainly intended for people who have trouble reading the default font.

Another recent addition is that the user can globally turn off the help balloons. This is the global default, in any GUI module you can turn it back on again. But that will not be remembered.

Colors

Select the colors to use: background color, colors for orbitals, and colors for other fields (this will be used by ADFview as default color when coloring a surface, or with cut planes). Occupied orbitals are orbitals that have electrons in them. Thus partially filled orbitals will have the same color as fully occupied orbitals.

To change a color click on the color which brings up a color selection box in RGB space.

Atom Colors

The color atoms by scalars option will be used to visualize scalar atomic values in for example ADFview and ADFinput. A mapping from the scalar range to the colors is used, and these are the extreme colors. The Scalar Range Symmetric checkbox forces the scalar range to be symmetric around zero, if negative values are present. If not checked, the extreme values of the scalars present will be used.

You can also change the default colors used when showing atoms. To do this, click on the '+' button and select for which atom type you wish to change the default color. The atom will be added to the Atom Colors panel, and you can select a color as with the other colors. To revert to the default color for this atom remove it by clicking the '-' button.

Fields

Specify some fields related preferences (currently only used by ADFview).

ADFjobs

Specify ADFjobs related preferences.
To use dynamic queues, click the + button in front of Dynamic Queues.

Two fields should appear. In the first field you should enter the hostname of the machine from which you wish to load the queue information. The second field may specify a username, if needed. This is the username that ssh will use to access the machine. If you leave the field at its default value (username), or make it blank, ssh will use the default username.

Next press Save or Apply.

Now the dynamic queues will be used automatically in ADFjobs.

You can add more dynamic queues from other machines, or you can remove machines using the - button.

**Environment**

Specify environment variable to be used.

Not all environment variables are shown: only those that are defined and that have to do something with ADF will be visible.

Use the '+' button to add new environment variables. You can also change the names of variables, or their values by editing the text.

The resulting environment is stored with the GUI preferences. They will be in effect for every program that is started from the ADF-GUI (or the BAND-GUI).

**Note:** these settings have no effect if you run ADF from the command line or on a remote host.